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ПЕРЕЛІК УМОВНИХ СКОРОЧЕНЬ 

БНК – базові несучі конструкції; 
PDE – диференціальні рівняння з частковими похідними; 
Bi – критерій Біо; 
Pe – критерій Пекле; 
Po – критерій Померанцева; 
Fo – критерій  теплової  гомохронності  Фур’є; 
Sk – критерій Старка; 
Re – критерій Рейнольдса; 
Pr – критерій Прандтля; 
Nu – критерій Нуссельта; 
Gr – критерій Грасхофа; 
Ra – критерій Релея; 
МКЕ – метод кінцевих елементів; 
x~ – характерний розмір тіла (товщина стінки);
τ – характерний час зміни зовнішніх умов; 
а – коефіцієнт температуропровідності (м2 · град –1); 
λ – коефіцієнт теплопровідності (Вт/м · град); 

Vq  – тепловий потік; 
σ – теплова провідність (Вт/град); 
θС – відносна температура середовища; 
r – прихована питома теплота фазового перетворення; 
ε – товщина твердої частини тіла по нормалі до двофазної границі; 
qР  – тепловий потік від рідкої фази до двофазної границі; 
K – критерій фізико-хімічного перетворення або критерій кристалізації; 
r – прихована питома теплота фазового перетворення; 
W  – швидкість потоку рідини відносно поверхні теплообміну; 

ηυ
ρ

=  – кінематична в'язкість;

η – динамічна в'язкість; 
ρ – густина; 
χ – коефіцієнт теплопровідності; 
cp – питома теплоємність середовища при постійному тиску; 
q – густина потоку теплоти (Вт/м2); 
tп – температура поверхні твердого тіла; 
tс – температура навколишнього середовища. 
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ПЕРЕДМОВА 

Однією з основних тенденцій розвитку сучасної обчислювальної 
техніки (ОТ), систем управління (СУ), радіотехнічних систем і т. д. є 
створення компактних пристроїв високої і надвисокої продуктивності, які 
можуть працювати не тільки на стаціонарних, але і на рухомих об'єктах. 
При цьому, однак, надзвичайно серйозною проблемою є забезпечення 
відведення великої кількості тепла, яке виділяється при роботі 
електронних елементів, перш за все, потужних мікросхем високої 
інтеграції (процесорів, модулів пам'яті), транзисторів, тиристорів, 
електронно-вакуумних приладів силових перетворювачів, підсилювачів, 
генераторів і т. д. Особливо актуальне це питання при розробці 
малогабаритних суперкомп'ютерних систем. Важливим питанням при 
цьому є розробка відповідних компактних систем, які забезпечують 
скидання тепла, що відводиться від апаратури, в навколишнє середовище. 
Складність є в тому, що в  системах охолодження базових несучих 
конструкцій до теплових повітряно-гідродинамічних процесів висуваються 
підвищені вимоги до адекватності і точності математичних та 
комп'ютерних моделей, які використовуються для розрахунку і оптимізації 
створюваних конструкцій. 

Математичне моделювання тепломасообмінних процесів при 
виробництві радіоелектронної апаратури (РЕА), тобто дослідження цих 
процесів, основане на їх математичному описі, досить давно 
використовується в техніці. Однак, в даний час, зміст математичного 
моделювання, його можливості та актуальність створення математичних 
моделей зазнали докорінних змін. Це пов'язано, по-перше, з відомими 
перевагами комп’ютерних методів перед натурним експериментом, по-
друге, зі швидким розвитком засобів обчислювальної техніки та її 
математичного забезпечення, і, нарешті, по-третє, з удосконаленням 
існуючих та розробкою нових чисельних методів реалізації складних 
математичних моделей, що використовують математичний апарат 
диференціального й інтегрального числення. Сучасні математичні моделі 
дозволяють одержати розрахунковим шляхом велику і досить точну 
інформацію про різні теплові і масообмінні процеси в техніці. Проведення 
обчислювальних експериментів з математичною моделлю, що реалізована 
у вигляді комп'ютерної програми, забезпечує скорочення термінів 
дослідження і зменшення його вартості, дозволяє прогнозувати поведінку 
досліджуваного об'єкта в різних, у тому числі і екстремальних, ситуаціях, 
створюючи таким чином основу для теплотехнічного обґрунтування 
проектних рішень при розробці нових і вдосконаленні існуючих 
електронних пристроїв з метою зниження енерго- та матеріалоємності РЕА 
та підвищення її якості.  

Математичною моделлю називається сукупність співвідношень 
(рівнянь, нерівностей, логічних умов), які з заданою точністю описують 
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властивості об'єкта, необхідні для мети дослідження. Рівень математичної 
моделі відповідає ієрархічному рівню системи або підсистеми, яку вона 
описує. Процес функціонування реального об'єкта описується 
математичною моделлю у вигляді послідовної зміни його станів. В кожний 
момент часу t стан об'єкта характеризується набором вихідних змінних y 
так, що його поведінка, тобто зміна стану в часі, описується функцією y (t). 
При відомому початковому стані y залежність y(t) визначається розв’язком 
системи рівнянь математичної моделі і може бути подана співвідношенням 
y (t) = F [x, c, t]. Тут x позначає набір вхідних змінних і параметрів моделі, 
які змінюються в процесі обчислювального експерименту, а c – сукупність 
внутрішніх параметрів моделі, які в процесі обчислювального 
експерименту зберігають постійні значення. Існує два основні підходи до 
знаходження конкретного виду залежності y (t) = F [x, c, t], що визначає 
зв'язок між вхідними і вихідними змінними (параметрами) математичної 
моделі.  

Теоретичний підхід базується на аналізі структури об'єкта і фізичної 
суті процесів, що протікають у ньому. Рівняння математичної моделі 
виражають при цьому фундаментальні теоретичні положення: закони 
збереження, закономірності явищ переносу, хімічної кінетики і т.д. Прості 
(лінійні) математичні моделі звичайно можуть бути реалізовані у вигляді 
аналітичних співвідношень, що виражають зв'язок досліджуваних 
характеристик з вихідними даними в явному вигляді. Більш складні 
(нелінійні) математичні моделі реальних об'єктів потребують для своєї 
реалізації розробки чисельних методів і застосування обчислювальної 
техніки. Обчислювальний експеримент проводиться в цьому випадку 
шляхом різноманітних розрахунків.  

Емпіричний підхід застосовується в тих випадках, коли теоретичні 
співвідношення не можуть бути використані внаслідок недостатньої 
вивченості модельованих процесів або коли заданий рівень моделювання 
робить недоцільним побудову складних теоретичних моделей. При 
емпіричному підході структура об'єкта вважається невідомою (об'єкт 
розглядається як "чорний ящик"), і функціональна залежність між 
вхідними і вихідними змінними встановлюється безпосередньо шляхом 
обробки даних натурного експерименту.  

Використання досить точних теоретичних моделей необхідно також 
для забезпечення самого процесу моделювання: при аналізі наслідків 
прийняття тих чи інших спрощувальних припущень і оціненням похибки 
спрощених методів розрахунку, при аналізуванні впливу неточності 
задання вихідних даних на значення вихідних змінних і т.д.  

Одним з основних етапів комп’ютерного моделювання 
тепломасообмінних процесів РЕА є розробка чи вибір алгоритму 
чисельного розв’язання задачі. Застосування цифрової обчислювальної 
техніки для реалізації математичної моделі стає можливим після 
дискретизації об'єкта, тобто заміни безперервного середовища його 
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дискретним аналогом. При цьому вихідні диференціальні та інтегральні 
рівняння замінюються апроксимувальною їх системою нелінійних 
алгебраїчних рівнянь, для розв’язання яких необхідно використання різних 
ітераційних процедур.  

Ефективність розрахункової схеми, тобто можливість отримання 
розв’язку із заданою точністю при мінімальному обсязі обчислень, є 
однією з основних вимог, що висуваються до алгоритму чисельного 
розв’язування задачі. Це пов'язано, по-перше, з багатоваріантним 
характером обчислювального експерименту, необхідністю проведення 
великих серій однотипних розрахунків. По-друге, ця вимога в ряді 
випадків визначає можливість використання алгоритму в системах 
управління об'єктом у реальному часі.  

В посібнику проаналізовано методи моделювання теплових процесів, 
показано умови подібності вимушеного конвективного теплообміну та 
вільної теплової конвекції, розглянуто сучасні програми  із моделювання 
теплових процесів в електронній апаратурі. Проведено порівняльний 
аналіз програмних продуктів для моделювання теплових процесів. 
Описано інтерфейс програми Thermal Desktop, показано моделювання 
теплових процесів та розподіл теплових полів  в РЕА. Навчальний 
посібник створено для студентів напряму підготовки 6.050902 – 
Радіоелектронні апарати освітньо-кваліфікаційний рівень – спеціаліст 
7.05090201 – Радіоелектронні апарати та засоби. 
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1 МОДЕЛЮВАННЯ ТЕПЛОВИХ ПРОЦЕСІВ 

1.1  Загальний огляд розвитку тепломасообміну 

Сучасний світ характеризується швидким розвитком усіх галузей 
науки. Величезне зростання кількості інформації було б катастрофічним 
для подальшого розвитку людського пізнання, коли б разом з розширенням 
та поглибленням наук все чіткіше не виявлялися б тенденції до їх синтезу і 
не створювались нові можливості автоматизації збереження і переробки 
інформації. 

У глибокому синтезі наук велику роль відіграє математика та прилеглі 
до неї повністю або частково математизовані науки та окремі дисципліни. 

Чим швидше розвивається теорія і чим більше накопичується наукової 
інформації, тим інтенсивніше повинні розвиватися і удосконалюватися 
експериментальні методи вивчення явищ природи. Як і раніше, 
експеримент залишається суттєвим інструментом пізнання. 

Ось чому теорія подібності і практика моделювання, які дозволяють 
концентрувати інформацію і є обґрунтуванням експерименту, дають 
напрямок для постановки дослідів і вказують на закономірність їх 
узагальнення. 

Закономірне узагальнення результатів одиничного явища ділиться на 
цілі групи подібних явищ за допомогою теорії подібності та  є необхідною 
умовою розвитку природничих і особливо технічних наук. Моделювання у 
самих різноманітних його проявах є необхідною умовою для постановки 
різноманітних дослідів [1-6]. 

Теорія подібності і моделювання охоплює всі області знань від 
дослідження мікросвіту до об’єктів такого масштабу як атмосферні течії, 
землетруси тощо. 

1.1.1  Критерії подібності теплових явищ 

Для визначення подібності двох явищ необхідно знати критерії, що їх 
визначають. Для визначення безрозмірних параметрів необхідно виявити 
процеси, які супроводжують протікання явища [4, 5, 8, 9, 14, 15].  

У загальному випадку теплові процеси, які протікають у рухомих 
середовищах визначаються законами переносу тепла і описуються 
рівнянням Фур’є – Кірхгофа. Аналіз цього рівняння показує, що в 
рухомому середовищі температурне поле залежить не тільки від 
теплофізичних параметрів, але і від розподілу швидкостей (поле 
швидкостей). Тому подібність процесів теплопереносу слід розглядати 
сумісно з диференціальними рівняннями руху. 

Критерії теплової подібності 
Для визначення критеріїв теплової подібності застосуємо метод 

відносних величин. 
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Зведемо рівняння переносу тепла до безрозмірної форми, необхідно 
додати до вже відомих відносних параметрів η  і U ще один, а саме, 
відносну температуру θ, яку можна визначити у загальному вигляді таким 
чином: 

 
min

max min

,t tQ
t t
−

=
−  (1.1) 

 

де mint  і maxt  – постійні  фіксовані значення температури, які 
визначають термічні умови протікання теплових процесів. 

Температурними параметрами mint  і maxt  можуть бути, наприклад, 
температура середовища, початкова температура процесу тощо. 

Умови подібності процесів теплопровідності 
Основним диференціальним  рівнянням нестаціонарної 

теплопровідності з внутрішнім джерелом тепла може бути (1.2). 
Застосування методу інтегральних аналогів  з використанням відносної 
координати та відносної температури (1.1) дозволяє записати його у 
безрозмірній формі: 

 ,Po
Fo 2

2
+

∂

∂
=

∂
∂

η
θθ  (1.2) 

 
,ix

x
η =

   

де 2~x
aFo τ

=
 
– критерій Фур’є або критерій гомохронності; 

)tt(
x~·qPo

maxmin

2
V
−

=
λ  

– критерій Померанцева; 

x~  – характерний розмір тіла (товщина стінки); 
τ – характерний час зміни зовнішніх умов; 
а – коефіцієнт температуропровідності (м2 · град –1); 

 
λ – коефіцієнт теплопровідності (Вт/м · град); 

Vq  – тепловий потік. 
Критерій Померанцева характеризує співвідношення кількості теплоти, 

що виділяє джерело тепла за одиницю часу до максимально можливої 
кількості тепла, яка передається теплопровідністю через стінку 
товщиною x~ . 
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Для визначення подібності процесів теплопровідності до критеріїв Fo і 
Po слід додати безрозмірні комплекси, які визначаються із краєвих умов 
процесу. 

Так, якщо тіло з середовищем обмінюється теплом за законом 
Ньютона-Ріхмана (граничні умови третього роду), то одержимо критерій 
Біо (Ві). 

У випадку, коли тіло сприймає тепло від середовища тепловим 
випромінюванням, то цю умову математично можна записати рівнянням: 

 

 4 4
T C

t (T T ),
x

λ εσ∂
− = −

∂
 ( )1.3

 

де λ – коефіцієнт теплопровідності (Вт/м · град); 
σ – теплова провідність (Вт/град). 
У безрозмірній формі рівняння (1.3) набуває вигляду: 

 
CSk( ),θ θ θ

η
∂

− = −
∂  

( )1.4
 

де ))·((
~··

minmax
2

min
2

max TTTTxSk ++=
λ
σε

 
– критерій Старка; 

θС – відносна температура середовища. 
Критерій Sk є аналогом критерію Біо (Bi) і виражає співвідношення 

потоків тепла випромінюванням та теплопровідністю. 
Інколи процеси нагрівання або охолодження супроводжуються 

плавленням або твердінням. До таких явищ переносу тепла можна також 
застосувати рівняння теплопровідності, у загальному вигляді для аналізу 
температурного поля в кожній із фаз – в твердій або рідкій окремо, але не 
разом. Це пов’язано з тим, що всередині системи діє рухоме джерело або 
стік тепла, а з двох боків від нього властивості середовища зазнають різких 
змін (тверда і рідка фази) [17] . 

Математично такі процеси відрізняються від процесів нагріву або 
охолодження без фазових перетворень особливими умовами на рухомій 
границі, де існує фазовий перехід – плавлення або твердіння. 

Для процесів з фазовими перетвореннями можна скласти умову на 
рухомій границі поділу твердої і рідкої фаз: 

 

 
· · ,p

dr q
x d
λ ελ ρ

τ
∂

− = +
∂  

( )1.5
 

 

10 



 

де r – прихована питома теплота фазового перетворення; 

τ
ε

d
d

 
– швидкість переміщення двофазної границі; 

ρ – густина частини тіла; 
ε – товщина твердої частини тіла по нормалі до двофазної границі; 
qР – тепловий потік від рідкої фази до двофазної границі. 
У відносних параметрах рівняння (1.5) набуває вигляду: 

 
· ,Ж

dK
dFo

θ ξ δ
η
∂

− = +
∂  

( )1.6
 

де x~
εξ =

 
– відносна товщина твердої фази; 

)·(

~

minmax tt
xqP

Ж −
=
λ

δ
 
– безрозмірний тепловий потік; 

2~x
aFo τ

=
 
– критерій Фур’є; 

)·( minmax ttc
rK
−

=
 

– критерій фізико-хімічного перетворення або 

критерій кристалізації; 
r – прихована питома теплота фазового перетворення. 
Критерій кристалізації (К) – це відношення прихованої теплоти 

фазового перетворення до затрат тепла на нагрівання тіла від t min до t max . 

1.1.2  Умови подібності вимушеного конвективного теплообміну 

Основним рівнянням переносу тепла у рухомому середовищі є 
рівняння Фур’є – Кірхгофа, яке можна записати у безрозмірній формі з 

введенням відносних параметрів: 
minmax

min

tt
tt
−
−

=θ  ; x
xi
~=η  і 

W
WU i

i ~=  . 

Одержимо: 
 

( )
2 2 2

2 2 2 1 7x y z·
x y z x y z

(U · U · U · )·Pe , .
Fo
θ θ θ θ θ θ θ

η η η η η η
∂ ∂ ∂ ∂ ∂ ∂ ∂

+ + + = + +
∂ ∂ ∂ ∂ ∂ ∂ ∂

 

де 2~x
aFo τ

=
 
– критерій Фур’є; 
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a
xWPe
~·~

=
 
– критерій Пекле (Pe); 

x~  – характерний розмір тіла (товщина стінки); 
τ – характерний час зміни зовнішніх умов; 
а – коефіцієнт температуропровідності (м2 · град –1); 
W  – швидкість потоку рідини відносно поверхні теплообміну. 
Критерій Пекле (Pe) являє собою міру відношення інтенсивності 

переносу тепла конвекцією до інтенсивності переносу тепла 
теплопровідністю. Іншими словами, критерій Pe є мірою відношення 
молярного і молекулярного механізмів переносу тепла. 

За структурою критерій Pe схожий з критерієм Рейнольда. Дійсно, 
чисельники обох критеріїв ( xW ~·~

) однакові. Знаменники характеризують 
фізичні константи: в першому випадку коефіцієнт температуропровідності, 
а у другому – коефіцієнт кінематичної в’язкості [17, 19]. 

Якщо виходити з означення критерію Pe, то можна сказати, що 
критерій Рейнольда характеризує міру відношення потоків кількості руху, 
здійснюваних під впливом молярного і молекулярного механізмів. 

Отже, різниця критеріїв Re і Pe полягає тільки у фізичних константах, 
які характеризують молекулярний перенос. 

У такому випадку доцільно виділити визначальні фізичні константи у 
самостійний критерій. Це легко досягається шляхом комбінування 
критеріїв Re і Pe у вигляді відношення: 

 

Pe Pr,
Re a

υ
= =

 
( )1.8

 

де ηυ
ρ

=  – кінематична в'язкість; 

η – динамічна в'язкість; 
 

ρ – густина; 
χ – коефіцієнт теплопровідності; 

p

a
C
χ

ρ
=

⋅
 – коефіцієнт температуропровідності; 

Сp –питома теплоємність середовища при постійному тиску. 

Відношення 
a
υ  прийнято називати критерієм Прандтля (Pr). Цей 

критерій відіграє дуже важливу роль у протіканні теплових процесів. 
Критерій  Pr складається лише із фізичних констант, а тому ми можемо 

стверджувати, що він характеризує теплофізичні властивості середовища, в 
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якому протікають теплові процеси. Якщо виходити з припущення, що 
фізичні властивості середовища незмінні, то критерій Pr має цілком 
конкретне числове значення. 

Для газів критерій Прандтля являє собою правильний дріб, близький 
до одиниці. Навпаки, для крапельних рідин, особливо для в’язких, він 
набагато більший за одиницю і досягає значень 10 3  і більше. Виняток 
складають рідкі метали, які характеризуються дуже малим значенням 
критерію Pr (10 – 2  і менше) [12,13]. 

Коефіцієнт температуропровідності характеризує здатність середовища 
реагувати зміною температури на проходження певної кількості теплоти. 
Аналогічним чином коефіцієнт кінематичної в’язкості характеризує його 
здатність реагувати зміною швидкості на проходження потоку кількості 
руху. Отже, ми  можемо стверджувати, що критерій Pr характеризує 
співвідношення між полем швидкості і температурним полем. Більш того, 
це співвідношення носить кількісний характер. Критерій Pr визначає 
співвідношення товщини теплового і гідродинамічного суміжних шарів. 
Останнє має велике значення для визначення природи теплових явищ. 

Для газового середовища (Pr < 1) інтенсивність процесу визначається 
конвективною складовою переносу тепла. Для металів (Pr << 1) домінуючу 
роль відіграє передача тепла теплопровідністю.  

Отже, аналіз рівнянь (1.7) і (1.8) показує, що подібність процесів 
передачі тепла в умовах вимушеної конвекції визначається трьома 
критеріями: вже відомими критеріями Fo і Re та критерієм Прандтля (Pr). 
Згідно з третьою теоремою про подібність явищ, наведені вище критерії 
Fo, Re і Pr можуть бути доповнені іншими критеріями, які визначаються із 
крайових умов процесу. 

Для виявлення додаткових критеріїв подібності складемо рівняння 
тепловіддачі, виходячи з таких міркувань. З теорії конвективного 
теплообміну відомо, що кількість тепла, яка конвективно дістається від 
середовища до поверхні теплообміну, пропорційна різниці температур 
середовища і поверхні теплообміну та коефіцієнту тепловіддачі й 
визначається рівнянням Ньютона – Ріхмана: 

 
п сq ·( t t ),α= −

  
де q – густина потоку теплоти (Вт/м2); 
tп – температура поверхні твердого тіла; 
tс – температура навколишнього середовища; 
α – коефіцієнт тепловіддачі. 
У безпосередній близькості від поверхні твердого тіла діє тільки 

молекулярний механізм переносу тепла (теплопровідність), тому 
інтенсивність теплообміну можна визначити за законом теплопровідності, 
тобто рівнянням Фур’є (1.9): 
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.tq

x
λ ∂

= −
∂  

( )1.9
 

Прирівнюючи праві частини цих рівнянь одержимо: 

 
·( ).c n

t t t
x

λ α∂
− = −

∂  
( )1.10

 

Нагадаємо, що у рівнянні (1.10) λ визначає коефіцієнт теплопровідності 
середовища. Рівняння (1.10) носить назву рівняння тепловіддачі. 
Приведення його до безрозмірної форми дає новий критерій подібності: 

 
·(1 ),Nuθ θ

η
∂

− = −
∂  

( )1.11
 

де 
λ
α xNu

~·
=

 
– безрозмірний параметр, який називається критерієм 

Нуссельта. 
Критерій Nu за своєю структурою тотожний критерію Bi. Різниця 

полягає у тому, що критерій Bi містить коефіцієнт теплопровідності 
твердого тіла, а критерій Nu – коефіцієнт теплопровідності середовища. 
Крім того, до критерію Bi коефіцієнт тепловіддачі  входить як відома 
величина, а коефіцієнт тепловіддачі, що входить до критерію Nu, є 
величиною, яку шукають. Його фізичний зміст можна охарактеризувати як 
параметр, що являє собою безрозмірну форму коефіцієнта тепловіддачі. 

1.1.3  Умови подібності вільної теплової конвекції 

За своєю фізичною природою процес вільного руху середовища являє 
собою такий перерозподіл елементів різної густини, за допомогою якого 
він переходить у більш сталий стан. Тверде тіло, внесене у середовище 
іншої температури, є джерелом порушення сталості. Першою причиною 
виникнення процесу служить теплова взаємодія між тілом і середовищем. 
Об’єми середовища, які прилягають до поверхні тіла, приймають його 
температуру. Починається процес поширення тепла за рахунок 
теплопровідності, що приводить до виникнення температурного поля. 
Зміна температури призводить до зміни густини середовища, внаслідок 
чого порушується початковий розподіл густини, що відповідає полю 
гідростатичного тиску [5].  

Для нового розподілу густини є характерним те, що в деяких зонах 
елементи більшої густини виявляються розташованими вище, ніж 
елементи з меншою густиною. Такий розподіл густини середовища є 
несталим тому, що йому не відповідає найменш можливе значення 
потенційної енергії системи. У такому випадку проявляється вплив 
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підйомної сили, що приводить до перерозподілу густини: більш нагріті 
об’єми зміщуються вгору, а менш нагріті – вниз. Причому, цей процес 
носить характер безперервного  взаємного зміщення елементів рідини. 

В умовах теплової конвекції, яка являє собою характерний випадок 
вільного руху, комплекс Pe втрачає роль критерію і перетворюється, як і 
критерій Re, у форму пошукову змінної швидкості руху (W). Тому 
необхідно вводити новий аргумент у вигляді критерію Pr.  

Розглянемо такий приклад. Нехай інерційні сили настільки малі 
порівняно з іншими силами, які діють у рідині, що, у такому разі, стає 
неможливим формування критерію Галілея (Ga), а, водночас, і критерію Fr 
та його модифікації Gr. Це стосується також і критерію Pr. Таким чином, із 
аналізу процесів подібності випадають критерії Ga і Pr. 

Проте з таких міркувань зовсім не випливає, що для даного випадку 
рівняння Нав’є – Стокса не повинно мати аргументів цього типу. Дійсно, 
виключивши із рівняння руху члени, відповідальні за інерційну силу, ми 
зовсім не втрачаємо можливості побудувати безрозмірні комплекси, до 
складу яких входила б швидкість. 

В окремих комбінаціях з критерієм Pe можна отримати комплекс, що 
не містить швидкості, зокрема критерій Pr. Комбінація з критеріями 
Рейнольда (Re) і Фрунда (Fr) дає критерій Галілея (Ga) та його 
модифікацію – критерій Грасгофа (Gr). 

Отже, виключення з аналізу рівняння руху сили інерції приводить до 
злиття двох критеріїв Gr і Pr в один у вигляді їх добутку Gr⋅Pr. 

У протилежному випадку, коли можна знехтувати силами в’язкості у 
рівнянні руху, із аналізу випадає критерій Re, а отже , і два похідні критерії 
Ga і Pr. Однак, при цьому зберігається критерій Фрунда (Fr), а тому 
комбінація критеріїв Pe і Fr дає новий параметр: 

 

2

· .Pe Pr Gr
Fr

= 2

 
( )1.12

 

Звідси витікає, що кінцеві рівняння будуть містити замість двох 
самостійних аргументів Pr і Gr один складний аргумент Gr·Pr2. 

Таким чином ми прийшли до  висновку, що між відносною величиною 
інерційної сили і структурою аргументів кінцевих рівнянь для вільного 
руху існують певні співвідношення. Малим відносним значенням 
інерційної сили відповідає аргумент виду Gr·Pr, а великим – Gr·Pr2. 

Для проміжної області, коли інерційна сила і сила внутрішнього тертя 
є величинами одного порядку, закономірності можуть бути апроксимовані 
параметром типу Gr·Prm , де 1<m<2. 

Цілком закономірно, що вплив інерційної сили на процес вільного руху 
повинен збільшуватися разом з критерієм Gr. Отже, малим значенням 
інерційної сили відповідає критерій типу Gr·Pr тому, що співмножник Pr 
для конкретної рідини практично є постійною величиною. При дуже 
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великих значеннях цього добутку більш точні результати дає застосування 
параметра у вигляді Gr·Prm . Форма добутку Gr·Pr2 відповідає процесам 
дуже високої інтенсивності, які поки що на практиці зустрічаються дуже 
рідко [12]. 

На завершення ще раз повернемось до комплексу Gr·Pr. Цей добуток 
називається критерієм Релея (Ra). Отже можемо записати Ra=Gr·Pr. 
Критерій Ra характеризує режим вільного руху середовища. 

1.2  Математичне моделювання теплообмінних процесів 

1.2.1  Деякі аспекти сучасного стану математичного моделювання 
тепломасообмінних процесів в техніці 

Математичне моделювання тепломасообмінних процесів при 
виробництві та обробці матеріалів (металів), при виробництві, передачі і 
розподілі теплової енергії, тобто дослідження цих процесів, основане на їх 
математичному описі, досить давно використовується в 
техніці [8, 9, 11, 12]. Однак, в даний час, зміст математичного 
моделювання, його можливості та актуальність створення математичних 
моделей зазнали докорінних змін. Це пов'язано, по-перше, з відомими 
перевагами цих методів перед натуральним експериментом, по-друге, зі 
швидким розвитком засобів обчислювальної техніки та її математичного 
забезпечення, і, нарешті, по-третє, з удосконаленням існуючих та 
розробкою нових чисельних методів реалізації складних математичних 
моделей, що використовують математичний апарат диференціального й 
інтегрального числення. 

Сучасні математичні моделі дозволяють одержати розрахунковим 
шляхом велику і досить точну інформацію про різні теплові і масообмінні 
процеси в техніці. Проведення обчислювальних експериментів з 
математичною моделлю, що реалізована у вигляді комп'ютерної програми, 
забезпечує скорочення термінів дослідження і зменшення його вартості, 
дозволяє прогнозувати поведінку досліджуваного об'єкта в різних, у тому 
числі і екстремальних ситуаціях, створюючи, таким чином, основу для 
теплотехнічного обґрунтування проектних рішень при розробці нових і 
вдосконаленні існуючих технологічних процесів з метою зниження енерго- 
та матеріалоємності виробництва і підвищення якості продукції. 
Математичною моделлю називається сукупність співвідношень (рівнянь, 
нерівностей, логічних умов), які з заданою точністю описують властивості 
об'єкта, необхідні для мети дослідження. Рівень математичної моделі 
відповідає ієрархічному рівню системи або підсистеми, яку вона описує. 
Наприклад, математична модель може описувати окремий процес тепло-
або масообміну, або комплекс процесів тепломасообміну в різних тепло-
технологічних чи енергетичних агрегатах. 
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Процес функціонування реального об'єкта подається до математичної 
моделі у вигляді послідовної зміни його станів. В кожний момент часу t 
стан об'єкта характеризується набором вихідних змінних y так, що його 
поведінка, тобто зміна стану в часі, описується функцією y(t). При 
відомому початковому стані y залежність y(t) визначається розв’язком 
системи рівнянь математичної моделі і може бути подана співвідношенням 
y(t) = F [x, c, t]. Тут x позначає набір вхідних змінних і параметрів моделі, 
які змінюються в процесі обчислювального експерименту, а c – сукупність 
внутрішніх параметрів моделі, які в процесі обчислювального 
експерименту зберігають постійні значення.  

Існує два основні підходи до знаходження конкретного виду 
залежності y(t) = F [x, c, t], що визначає зв'язок між вхідними і вихідними 
змінними (параметрами) математичної моделі.  

Теоретичний підхід базується на аналізі структури об'єкта і фізичної 
суті процесів, що протікають у ньому. Рівняння математичної моделі 
виражають при цьому фундаментальні теоретичні положення: закони 
збереження, закономірності явищ переносу, хімічної кінетики і т.д. Прості 
(лінійні) математичні моделі звичайно можуть бути реалізовані у вигляді 
аналітичних співвідношень, що виражають зв’язок досліджуваних 
характеристик з вихідними даними в явному вигляді. Більш складні 
(нелінійні) математичні моделі реальних об'єктів потребують для своєї 
реалізації розробки чисельних методів і застосування обчислювальної 
техніки. Обчислювальний експеримент проводиться в цьому випадку 
шляхом різноманітних розрахунків.  

Емпіричний підхід застосовується в тих випадках, коли теоретичні 
співвідношення не можуть бути використані внаслідок недостатньої 
вивченості модельованих процесів або коли заданий рівень моделювання 
робить недоцільним побудову складних теоретичних моделей. При 
емпіричному підході структура об'єкта вважається невідомою (об'єкт 
розглядається як "чорний ящик"), і функціональна залежність між 
вхідними і вихідними змінними встановлюється безпосередньо шляхом 
обробки даних натурного експерименту [7, 19].  

Проміжне положення між двома розглянутими видами математичних 
моделей займають моделі змішаного типу. Вони будуються, як правило, на 
основі одного рівняння або невеликого числа рівнянь, що описують 
механізм лише найбільш суттєвих для даного натурного зразка процесів. 
Вплив усіх інших процесів враховується в такій моделі за допомогою 
деяких параметрів, які називаються іноді підстроювальними 
коефіцієнтами. Значення цих параметрів визначають за допомогою 
адаптації або параметричної ідентифікації математичної моделі за 
результатами експериментальних досліджень. Адаптацію моделей 
змішаного типу необхідно виконувати для кожного агрегата (або для 
кожного типу агрегатів) індивідуально.  
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Емпіричні моделі та моделі змішаного типу зазвичай 
використовуються в системах автоматизованого управління поведінкою 
конкретних об'єктів. Теоретичні або детерміновані математичні моделі 
мають набагато більш широку сферу застосування. Перш за все, вони 
можуть бути використані для аналізу впливу різних факторів на перебіг 
досліджуваних процесів, прогнозування поведінки реальних або 
проектованих об'єктів і прийняття на цій основі оптимальних рішень. 
Комп'ютер виступає в цьому випадку як "інструмент пізнання, засіб 
проникнення вглиб досліджуваних процесів та управління ними на основі 
отриманих знань". Крім того, обчислювальний експеримент є ефективним, 
а в деяких випадках єдиним засобом вивчення властивостей реальних 
об'єктів шляхом обробки експериментальних даних у рамках вирішення 
відповідних обернених задач і знову проектованих агрегатів.  

Використання досить точних теоретичних моделей необхідно також 
для забезпечення самого процесу моделювання: при аналізі наслідків 
прийняття тих чи інших спрощуючих припущень і оцінкою похибки 
спрощених методів розрахунку, при аналізі впливу неточності завдання 
вихідних даних на значення вихідних змінних і т. д.  

Дослідження об'єкта методом математичного моделювання 
проводиться в такий спосіб. Спочатку проводиться розробка математичної 
моделі, що передбачає виконання таких дій.  

Постановка задачі:  
• формулювання мети дослідження;  
• якісний опис поведінки об'єкта та його схематизація, тобто прийняття 

спрощувальних припущень і виділення властивостей об'єкта, істотних для 
мети дослідження;  

• вибір змінних і визначення параметрів майбутньої математичної 
моделі (значення деяких параметрів – настроювальних коефіцієнтів – 
можуть бути визначені пізніше, на етапі ідентифікації моделі);  

• задання точності розрахунку вихідних змінних.  
На етапі постановки завдання проводиться структуризація об'єкта, 

тобто його поділ на блоки і якісний опис зв'язків між окремими блоками. 
Наприклад, при побудові математичної моделі теплової роботи печей-
теплообмінників доцільно виділити два основні блоки, що відрізняються 
механізмом перенесення тепла і характером математичного опису 
теплообміну.  

Перший з них охоплює процеси теплообміну в зоні генерації тепла, що 
визначають постановку зовнішньої задачі теплообміну. Другий блок 
описує перенесення тепла в зону технологічного процесу, що визначає 
постановку внутрішньої задачі теплообміну. Крім необхідності сполучення 
зовнішнього і внутрішнього теплообміну на поверхні твердих тіл, іноді в 
практиці математичного моделювання потрібно враховувати взаємний 
вплив теплообміну і процесів іншої фізичної природи.  
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Наприклад, взаємний вплив теплових і електромагнітних полів при 
індуктивному нагріві та взаємодії процесів теплообміну і процесів 
деформування металу. 

1.2.2  Математичне формування завдання 

Запис рівнянь, нерівностей, логічних умов для кожного блоку 
математичної моделі, а також співвідношень, що виражають зв'язки між 
окремими блоками. При цьому для різних блоків моделі можливе 
використання як теоретичних, так і емпіричних моделей. Так, наприклад, 
для опису залежності теплофізичних характеристик тіл від температури в 
рамках деякої теоретичної (детермінованої) моделі зазвичай 
використовуються найпростіші емпіричні співвідношення [10].  

Теоретичні, фізично обґрунтовані моделі записуються у формі систем 
нелінійних диференціальних та інтегральних рівнянь. Основними 
причинами нелінійності теплофізичних моделей є: 

• залежність теплофізичних властивостей тіл від температури;  
• селективність радіаційних властивостей тіл, тобто залежність 

спектральних ступенів чорноти від довжини хвилі;  
• складний характер теплообміну, тобто одночасне протікання процесів 

радіаційного, конвективного і кондуктивного теплообміну;  
      • наявність фазових перетворень, що супроводжують процеси 
перенесення тепла; 

• турбулентний характер руху теплоносіїв;  
• наявність хімічних реакцій, в тому числі реакцій горіння;  
• необхідність розв’язання сполучених завдань, тобто узгодження 

рішень, які визначаються окремими блоками математичної моделі.  

1.2.3  Розробка алгоритму чисельного рішення задачі 

 Застосування цифрової обчислювальної техніки для реалізації 
математичної моделі стає можливим після дискретизації об'єкта, тобто 
заміни безперервного середовища його дискретним аналогом. При цьому 
вихідні диференціальні та інтегральні рівняння замінюються  системою 
нелінійних алгебраїчних рівнянь, для розв’язання яких необхідно 
використання різних ітераційних процедур.  

Реалізація математичних моделей, які використовуються в 
теплотехніці, у ряді випадків потребує розробки нових чисельних методів, 
що враховують специфіку математичного опису теплофізичних процесів. 
Так, постановка задачі теплопровідності при наявності фазових 
перетворень, яка виникає, зокрема, при аналізі теплової взаємодії твердих 
тіл зі сплавами, приводить до необхідності побудови алгоритмів, що 
враховують рух межі розрахункової області. При моделюванні 
сполученого теплообміну в нагрівальних та термічних печах використання 
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зональної методики для розв’язання зовнішньої задачі і методу кінцевих 
різниць для розв'язання внутрішньої задачі призводить до специфічної 
проблеми спільного розв'язання систем зональних та різницевих 
рівнянь [11].  

Ефективність розрахункової схеми, тобто можливість отримання 
розв’язку із заданою точністю при мінімальному обсязі обчислень, є 
однією з основних вимог, що висуваються до алгоритму чисельного 
розв’язання задачі [17]. Це пов'язано, по-перше, з багатоваріантним 
характером обчислювального експерименту, необхідністю проведення 
великих серій однотипних розрахунків. По-друге, ця вимога в ряді 
випадків визначає можливість використання алгоритму в системах 
управління об'єктом у реальному часі.  

Для підвищення ефективності алгоритму в деяких випадках потрібно 
повернення до попереднього пункту і змінення форми запису рівнянь 
математичної моделі. При цьому до істотних спрощень приводить 
реалізація того чи іншого блоку моделі у вигляді явної формули.  

Слід зазначити, що більш плідним може виявитися підхід, в рамках 
якого дискретизація об'єкта проводиться вже на етапі постановки завдання; 
в цьому випадку у вигляді системи алгебраїчних рівнянь записується 
вихідна математична модель. В подальшому реалізовується алгоритм 
комп'ютерної програми.  

Перевірка адекватності моделі є підтвердженням її відповідності 
досліджуваному об'єкту. Математична модель вважається адекватною, 
якщо зіставлення результатів моделювання з даними про поведінку 
реального об'єкта показує, що досліджувані характеристики 
відтворюються в моделі з необхідною точністю. 

Для перевірки адекватності моделі, як правило, проводять:  
• серію пробних розрахунків та якісний аналіз поведінки математичної 

моделі;  
• аналіз справедливості спрощувальних припущень, прийнятих на етапі 

постановки завдання, шляхом зіставлення результатів розрахунку з 
розв’язком задачі в більш строгій постановці;  

• ідентифікацію параметрів моделі: визначення значень 
настроювальних коефіцієнтів шляхом зіставлення результатів розрахунку з 
експериментальними даними. Для емпіричних моделей на цьому етапі 
використовуються методи регресійного аналізу, для теоретичних – апарат 
рішення обернених задач.  

Обов'язковість даного етапу є наслідком наближеного характеру 
моделювання, обумовленого схематизацією, спрощенням процесів, що 
протікають у реальному об'єкті, а також можливістю прийняття неточних 
або помилкових рішень при побудові моделі. У тому випадку, якщо модель 
виявляється неадекватною, слід повторити всю описану процедуру, 
починаючи з етапу постановки завдання.  
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Після розробки математичної моделі проводиться її дослідження 
шляхом проведення обчислювального експерименту та інтерпретація 
отриманих даних, тобто перенесення результатів обчислювального 
експерименту на досліджуваний об'єкт з виробленням рекомендацій щодо 
їх практичного використання.  

Процес створення математичних моделей не піддається жорсткій 
формалізації. Проблеми, варті обговорення, виникають на всіх етапах 
математичного моделювання. Зупинимося на деяких з них.  

Особливістю математичного моделювання як методу наукового 
дослідження є тісне поєднання формальних і неформальних процедур. 
Виділення істотних властивостей досліджуваного об'єкта, пошук способів 
їх адекватного відтворення в моделі потребують від дослідника не тільки 
глибокого розуміння механізму модельованих процесів, а й значною мірою 
базуються на його досвіді і інтуїції. Прийняття спрощувальних припущень, 
гіпотез, пов'язаних з браком інформації про деякі сторони функціонування 
об'єкта, багато в чому надають процесу створення моделі творчий 
характер. 

Вказана обставина призводить, однак, до можливості прийняття 
неточних або помилкових рішень при побудові моделі, з чим пов'язана 
необхідність обов'язкової перевірки її адекватності.  

Одним з найбільш трудомістких і відповідальних етапів математичного 
моделювання є розробка алгоритму чисельного розв’язання задачі. Це 
обумовлено, головним чином, необхідністю забезпечення збіжності 
ітераційних розрахункових схем і підвищення їх ефективності, тобто 
досягнення заданої точності розв’язку поставленого завдання з 
мінімальними обчислювальними витратами. При цьому з розвитком 
обчислювальної техніки завдання підвищення ефективності розрахункових 
схем не стає менш актуальним. Навпаки, збільшення продуктивності і 
оперативної пам'яті сучасних комп'ютерів створює можливість постановки 
все більш складних різноманітних завдань, ефективне вирішення яких 
потребує постійного вдосконалення чисельних методів [5, 14, 17].  

Як вже було зазначено вище, перевірка адекватності математичних 
моделей є необхідним етапом їх побудови. З цього безперечного 
твердження часто робиться висновок про те, що право на існування мають 
тільки ті моделі, адекватність яких доведено шляхом зіставлення 
результатів розрахунку з даними натурного експерименту. При цьому все 
зрозуміло, якщо мова йде про моделювання існуючого об'єкта, наприклад, 
з метою опрацювання проектних рішень при реконструкції існуючого 
агрегату. Для цього на наявному агрегаті проводяться експерименти з 
перевірки адекватності математичної моделі, яка потім використовується 
для дослідження різних варіантів конструкції або теплотехнологічного 
режиму. У той же час дуже часто виявляються затребуваними  математичні 
моделі, призначені для теплотехнічного обґрунтування здійснення нового 
технологічного процесу або можливості функціонування нової 
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теплотехнічної системи. У цьому випадку формальна кількісна перевірка 
адекватності математичної моделі в принципі неможлива, оскільки 
реального об'єкта дослідження не існує.  

При цьому підтвердженням адекватності математичної моделі може 
служити лише та обставина, що при її побудові не тільки були правильно 
враховані фундаментальні закони природи і експериментально 
підтверджені функціональні залежності, але крім цього – не був 
порушений здоровий глузд. З цього приводу доречно процитувати слова 
відомого вченого М. М. Мойсеєва про математику як про сувору науку: 
"Але все має свої розумні межі. Інтуїція, досвід – все те, що зазвичай 
називається здоровим глуздом або неформальним мисленням, такою ж  
мірою має законне право на існування при аналізі математичних задач, як і 
все інше".  

Збільшення продуктивності і оперативної пам'яті сучасних 
персональних комп'ютерів привело до різкого розширення кола 
теплотехнічних задач, які успішно вирішуються методом математичного 
моделювання, і в результаті – до формування думки про те, що 
комп'ютерне моделювання є універсальним засобом для вирішення всіх 
проблем. На щастя, ця помилка поступово проходить, і виникає розуміння 
того, що математичне моделювання – не панацея, а робочий інструмент 
для вирішення конкретних практичних завдань.  

Вибір рівня моделювання (рівня деталізації досліджуваного об'єкта), 
вироблений дослідником на етапі постановки завдання, в кожному 
конкретному випадку пов'язаний з вирішенням питання про доцільність 
створення складних, універсальних моделей, детально відтворюють різні 
сторони поведінки реального об'єкта. Принципова відповідь на це питання 
дає системний підхід, згідно з рекомендаціями якого, складність розробки 
не повинна перевищувати складності, необхідної для досягнення 
поставленої мети. Іншими словами, модель повинна бути настільки 
складною, наскільки це необхідно для вирішення поставленого завдання. 
Надмірність моделювання – неефективна.  

Подальший розвиток математичного моделювання теплових процесів, 
на наш погляд, піде шляхом автоматизації деяких етапів створення 
математичних моделей, таких як вибір ефективного чисельного методу, 
пошук найкращого алгоритму розв’язання і створення обчислювальної 
програми, залишивши на частку розробника концептуальне моделювання, 
математичне формулювання завдання, адаптацію математичної моделі та 
аналіз результатів моделювання.  

Шлях розробки універсальних програм (пакетів) з розрахунку тих чи 
інших фізичних процесів, на наш погляд, є тупиковим. Тому що, по-перше, 
універсальність досягається невиправданим ускладненням пакета програм, 
і, по-друге, абсолютна універсальність обчислювальної програми, в 
принципі, є недосяжною. Тому для вирішення конкретної фізичної 
(теплотехнологічної) задачі доцільно створювати свою оригінальну 
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математичну модель, реалізовану у вигляді конкретно визначеної 
обчислювальної програми. 

На закінчення можна з упевненістю стверджувати, що розширення 
областей застосування методів математичного моделювання для 
теплотехнічного прогнозу і підвищення рівня досліджень призводить до 
такого зростання значення і складності проблем, які виникають на етапі 
реалізації моделі, що обчислювальна теплофізика, предметом якої є 
розробка й удосконалення алгоритмів чисельного розв'язання нелінійних 
теплофізичних завдань, може розглядатися як самостійний науковий 
напрям. Розвиток цього напрямку створює основи для розробки сучасних 
методів вирішення практичних завдань у техніці.  

1.2.4 Методи розв’язання задач тепломасообміну 

Існують різні класифікації методів розв'язання задач тепло-і 
масообміну, теплопровідності і дифузії іноді зводяться до звичайних 
диференціальних рівнянь [5, 13, 20].  

Всі вони в основному доповнюють один одного, з огляду на ті чи інші 
особливості методів отримання рішень (див., наприклад, книги 
Л. А. Коздоба, А. Д. Полянина тощо) і їх подальшої реалізації для 
інженерних розрахунків.  

Всі способи розв’язань можна поділити на аналітичні методи і на 
чисельні методи.  

Аналітичні методи розв’язань (не самих постановок завдань) можна 
поділити на точні і наближені.  

Чисельні рішення завжди є наближеними.  
Чисельні та аналітичні методи мають свої переваги і недоліки. 

Причому, як правило, перевазі одного методу відповідає недолік другого. 
Наприклад: чисельні методи дозволяють розв’язувати складні крайові 
задачі, розв’язання яких аналітично або неможливо, або пов’язано з 
великими труднощами. Аналітичні методи, що подають розв’язки у 
вигляді функції, дозволяють аналізувати вплив вихідних параметрів на 
результат розв’язання, що важко виконати при чисельних методах.  

Часто аналітичним розв’язком можна вважати, як вже говорилося 
вище, подання завдання в вигляді певного інтеграла («квадратури»), а іноді 
навіть у вигляді звичайного диференційного рівняння.  

Наближені аналітичні методи передбачають отримання наближеного 
розв'язку в результаті перетворення, розбиття або спрощення вихідної 
точної постановки завдання (наприклад: асимптотичні методи; інтервальні 
методи).  

Важливо також відзначити можливість наближеного розв'язання 
нелінійних задач і завдань взаємопов’язаного перенесення. Розв’язання 
подібних практичних завдань в точній аналітичній формі вдається рідко.  
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Реалізація всіх видів розв’язань – завжди чисельна і наближена. Для 
цього використовується  ручний рахунок, розрахунки на калькуляторах, а 
найчастіше в даний час – комп'ютерні розрахунки.  

Комп'ютерні програми можуть розроблятися спеціально для отриманих 
розв’язків або можуть використовуватися пакети програм, що 
розробляються комп'ютерними фірмами.  

Для оціночних та експресних інженерних розрахунків у ряді випадків 
використовуються таблиці, номограми і графіки.  

Для аналітичного рішення лінійних задач теплопровідності (дифузії) в 
шаруватих тілах застосовуються основні класичні методи:  

– метод розділення змінних (метод Фур'є),  
– метод джерел (або метод функцій Гріна),  
–  методи перетворення Лапласа та інші методи інтегральних 

перетворень.  
Кожен з них має свої переваги і недоліки. До переваг можна віднести 

простоту їх освоєння та застосування, до недоліків – громіздкість 
одержуваного розв’язку [14].  

В даному посібнику будемо розглядати насамперед аналітичні 
розв’язання рівнянь теплопровідності і дифузії в частинних похідних, і в 
лінійних постановках.  

1.2.5  Метод кінцевих елементів 

МКЕ – один з найбільш гнучких і універсальних методів вирішення 
широкого кола задач механіки суцільного середовища, тепло- і 
масообміну, електро- і магнітостатики та багатьох інших завдань науки і 
техніки [14].  

Історія розвитку методу 
Виникнення методу кінцевих елементів пов'язано з вирішенням 

завдань космічних досліджень в 1950-х роках. Ідея МСЕ була розроблена в 
СРСР ще в 1936 році , але через нерозвиненість обчислювальної техніки 
метод не отримав розвитку, тому вперше був застосований на ЕОМАргіріс 
лише у 1944 році. Цей метод виник з механіки і теорії пружності, а вже 
потім було отримано його математичне обгрунтування. Істотний поштовх 
у своєму розвитку МКЕ отримав у 1963 після того, як було доведено те, що 
його можна розглядати як один з варіантів поширеного в механіці методу 
Релея-Рітца, який шляхом мінімізації потенційної енергії зводить задачу до 
системи лінійних рівнянь рівноваги. Після того, як було встановлено 
зв'язок МКЕ з процедурою мінімізації, він став застосовуватися до завдань, 
описуваних рівняннями Лапласа або Пуассона. Область застосування МКЕ 
значно розширилася, коли було встановлено (у 1968 році), що рівняння, які 
визначають елементи в задачах, можуть бути легко отримані за допомогою 
варіантів методу зважених нев'язок, таких як метод Гальоркіна або метод 
найменших квадратів. Це відіграло важливу роль в теоретичному 
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обгрунтуванні МКЕ, тому що дозволило застосовувати його при 
розв’язуванні багатьох типів диференціальних рівнянь. Таким чином, 
метод кінцевих елементів перетворився на загальний метод чисельного 
розв’язання диференціальних рівнянь або систем диференційних рівнянь. 

З розвитком обчислювальних засобів можливості методу постійно 
розширюються, також розширюється і клас розв'язуваних задач. 
Практично всі сучасні розрахунки на міцність проводять, використовуючи 
МКЕ. 

Ідея методу 
Суть методу походить з його назви. Область, у якій відшуковується 

розв’язок диференціальних рівнянь, розбивається на скінченну кількість 
підобластей (елементів). У кожному з елементів довільно вибирається вид 
апроксимувальної функції. У найпростішому випадку це поліном першого 
ступеня. Поза своїм елементом апроксимувальна функція дорівнює нулю. 
Значення функцій на границях елементів (вузлах) заздалегідь невідомо. 
Коефіцієнти апроксимувальних функцій зазвичай визначаються з умови 
рівності значення сусідніх функцій на границях між елементами (у вузлах). 
Потім ці коефіцієнти виражаються через значення функцій у вузлах 
елементів. Складається система лінійних алгебраїчних рівнянь.  

Кількість рівнянь дорівнює кількості невідомих значень у вузлах, на 
яких відшуковується розв’язок вихідної системи, прямо пропорційна 
кількості елементів і обмежується тільки можливостями ЕОМ. Оскільки 
кожен з елементів пов'язаний з обмеженою кількістю сусідніх, система 
лінійних алгебраїчних рівнянь має розріджений вигляд, що істотно 
спрощує її розв’язання. 

З точки зору обчислювальної математики, ідея методу кінцевих 
елементів полягає в тому, що мінімізація функціонала варіаційної задачі 
здійснюється на сукупності функцій, кожна з яких визначена на своїй 
підобласті, для чисельного аналізу системи дозволяє розглядати його як 
одну з конкретних гілок загального методу дослідження систем шляхом їх 
розчленовування. 

Переваги та недоліки 
Метод кінцевих елементів, за словами фахівців, "велика гармата" –

 метод кінцевих різниць і простіший в реалізації, і швидший. Зате у МКЕ є 
свої переваги, які проявляються на реальних завданнях: довільна форма 
оброблюваної області; сітку можна зробити більш розрідженою в тих 
місцях, де особлива точність не потрібна. 

Довгий час значному поширенню МКЕ заважала відсутність 
алгоритмів автоматичного розбиття області на "майже рівносторонні" 
трикутники (похибка, залежно від варіації методу, обернено пропорційна 
синусу або найменшого гострого, або найбільшого тупого кута в розбитті). 
Втім, це завдання вдалося успішно вирішити (алгоритми грунтуються на 
тріангуляції Делоне). 
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Система ELCUT 
CAE – система ELCUT дозволяє розв’язувати двовимірні крайові 

задачі математичної фізики, що описуються еліптичними 
диференціальними рівняннями з частинними похідними відносно 
скалярної або однокомпонентної векторної функції (потенціалу), а також 
задачі розрахунку напружено-деформованого стану твердого тіла (плоскі 
напруги, плоскі деформації, асиметричні навантаження).  

Система ELCUT призначена для розрахунків МКЕ плоских і 
асиметричних (двовимірних) завдань:  

• лінійної і нелінійної магнітостатики,  
• магнітного поля змінних струмів (з урахуванням вихрових струмів),  
• електростатики,  
• розтікання струмів в провідному середовищі,  
• лінійної і нелінійної теплопровідності,  
• лінійного аналізу напружено-деформованого стану,  
• пов'язані (мультидисциплінарні) завдання.  
Температурний аналіз відіграє помітну роль при проектуванні багатьох 

механічних і електромагнітних систем. Як правило, інтерес становлять 
розподіли температури, температурного градієнта і теплового потоку [2].  

ELCUT може виконувати лінійний і нелінійний стаціонарний 
температурний аналіз у плоскій і асиметричній постановці. Формулювання 
задачі ґрунтується на стаціонарному рівнянні теплопровідності з 
граничними умовами радіаційного та конвективного теплообміну.  

При постановці задачі можливе використання таких можливостей.  
Властивості середовищ:  
ортотропні матеріали з постійною теплопровідністю; ізотропні 

матеріали з теплопровідністю, що залежить від температури.  
Джерела поля:  
постійні та залежні від температури об'ємні джерела теплової 

потужності;конвективні та радіаційні джерела;потужність джоулевих 
втрат, імпортованих із завдання розтікання струмів.  

Граничні умови:  
задана температура, заданий тепловий потік на границі, умови 

радіаційного та конвективного теплообміну, поверхні з постійною, наперед 
невідомою температурою.  

Результати розрахунку:  
температура, градієнт температури, щільність теплового 

потоку,інтегральні значення теплового потоку через задані поверхні.  
Спеціальні можливості: інтегральний калькулятор може обчислювати 

різні інтегральні значення на певних лініях і поверхнях. Розподіл 
температури може бути переданий до завдання розрахунку механічного 
напруженого стану. 
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1.2.6  Метод кінцевих різниць 

Розв’язання рівняння нестаціонарного процесу теплопровідності 
методом кінцевих різниць [14]. Метод кінцевих різниць оснований на 
заміні похідних їх наближеними значеннями, вираженими через різниці 
значень функцій в окремих дискретних точках – вузлах сітки.  

Вихідним рівнянням є:  

( )
2

2 , 1.13T T
t t

α∂ ∂
=

∂ ∂  
де Т – відповідає температурі; 
α – коефіцієнт теплопровідності. 
Риска зверху символізує точне рішення. 
Як перший крок на шляху до розробки алгоритму розрахунку тих 

значень Т, які можуть фігурувати в рівнянні (1.13), виразимо похідні Т за 
простором і часом у вузлі (j, n) через значення Т в сусідніх вузлах. Для 
реалізації цього процесу скористаємося розкладанням в ряди Тейлора типу  

 
1

0
,

!

nm m
n

j m
n j

x TT
m x

∞

+
=

 ∆ ∂
=  

∂  
∑

 
( )1.14

 

 

1

0
.

!

nm m
j

n m
n j

е TT
m t

∞
+

=

 ∆ ∂
=  

∂  
∑

 
( )1.15

 

 
Ці ряди можуть бути обірвані після будь-якого числа членів, причому 

виникає в результаті похибка (похибка апроксимації), яка визначається, в 
основному, наступним членом розкладання, якщо тільки Δх ˂ 1 в 
розкладанні (1.14) або якщо Δе ˂ 1 в розкладанні (1.15). 

Отже можна записати  
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Звертаючись до виразу (1.16), неважко побачити, що кінцево-різницеві 
подання дТ/дх можна отримати безпосередньо. Дійсно, перегрупування 
членів у (1.16) дає  
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Очевидно, що використання кінцево-різницевої підстановки  

( )1 1.18
n n n

j j
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T TT
x x

+ − ∂
≈ ∂ ∆   

забезпечує точність 0(Δх). Додаткові члени, які фігурують у правій частині 
(1.17), називаються надалі похибкою апроксимації. Вираз в правій частині 
формули (1.18) називається апроксимацією з різницею вперед. Якщо 
розкласти величину Tj-1

n  в ряд Тейлора у вузлі (j, п) і перегрупувати члени, 
то можна побудувати апроксимацію з різницею, тому: 
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Як і (1.18), ця апроксимація вносить похибку. Геометрична 
інтерпретація виразів (1.18) та (1.19) зображена на рисунку 1.1. 

Формула (1.19) оцінює 
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 через нахил лінії АС, тоді як формула (1.18) 

дає ту ж оцінку за допомогою нахилу АВ. 
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Рисунок 1.1 – Різні варіанти звичайно-різницевого подання дТ/дх 
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Формули (1.18) та (1.19) були отримані за допомогою розкладання в 
ряд Тейлора за простором. Розкладання в ряд Тейлора за часом – формула 
(1.16) – може бути використана для побудови апроксимації з різницею 
вперед  
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яка вносить похибку O( t )∆ , якщо тільки припустити, що Δt ˂ 1 і що похідні 
вищих порядків обмежені.  

Центрована (або центральна) різницева апроксимація для 
n

j

Т
х

∂ 
 ∂ 

 має 

форму  

( )1 1 1.21
2

n n n
j j

j

T TT
x x

+ −− ∂
≈ ∂ ∆   

з помилкою апроксимації 2O( x )∆ . Очевидно, що центрована різницева 
апроксимація вносить похибку апроксимації більш високого порядку, ніж 

апроксимації вперед (1.18) і назад (1.19). Формула (1.31) оцінює 
n

j

Т
х

∂ 
 ∂ 

 за 

нахилом лінії АС на  рисунку 1.1. 
 

Для 
n

j

Т
х

∂ 
 ∂ 

 отримаємо таку центровану різницеву формулу:  

 
1 1 2

2 0( ).
n n n n

j j j

j

T T TT x
x x

− +− + ∂
≈ + ∆ ∂ ∆   

( )1.22
 

 
Дискретизація 
Щоб перетворити вихідне рівняння з частинних похідних (або систему 

таких рівнянь) на систему алгебраїчних рівнянь, можна вибрати один з 
декількох варіантів. Найбільш загальноприйнятими є метод кінцевих 
різниць, метод кінцевих елементів і спектральний метод. Спосіб 
здійснення дискретизації залежить також від того, чи розглядаються 
похідні за часом (у застосуванні до задач із залежністю від часу) або ж 
рівняння, що містять тільки просторові похідні. 

Для ілюстрації процесу дискретизації розглянемо рівняння (1.21), яке 
визначає нестаціонарний процес теплопровідності в одному вимірі. 
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Символ Т відповідає температурі, символ α  – коефіцієнт 
теплопровідності. Риска зверху символізує точне значення. 

 

t=n∆t

2∆t

∆t

∆x 2∆x (j-1)∆x (J-1)∆x

1 j=2 j=3 j
n-1

n

n+
1

j-1
n-2

n=1

n=0

t

x

 
Рисунок 1.2 – Дискретна сітка 

 
Найбільш прямий шлях дискретизації полягає в заміні похідних 

еквівалентними їм звичайно-різницевими виразами. Так, наприклад, на 
основі (1.18) і (1.19) рівняння (1.21) можна замінити рівнянням: 

( )
1

1 1
2

( 2 )
. 1.23

n n n n n
j j j j jT T T T T

t x

α+
− +− − +

=
∆ ∆

 
Розміри кроків t , x,∆ ∆  а так само значення нижнього індексу j і 

верхнього індексу n вказуються на рисунку 1.2. У рівнянні (1.22) 
символ n

jT  відповідає значенню Т у вузлі (j, п). 
Як це випливає з самого процесу дискретизації, що перетворює 

рівняння (1.21) на рівняння (1.22), задача про знаходження точного 
(безперервного) розв’язку Т(х, t) виявилася в заміні на задачу про 
знаходження сукупності дискретних значень n

jT , тобто в наближенні 
рішення в кожному з вузлів (j, п) (рис. 1.2). При цьому виникають два 
пов'язані між собою рівняння. Якщо рівняння (1.21) є диференціальним 
рівнянням в частинних похідних, то рівняння (1.23) – алгебраїчне. Якщо 
подивитися на рисунок 1.2, то за допомогою рівняння (1.23) можна 
отримати формулу або алгоритм для визначення невідомого значення 1n

jT +  
залежно від відомих значень на n-му часовому рівні, тобто знайти вираз: 
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∆
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Щоб побудувати повне чисельне рішення на тимчасовому рівні (n+1), 

слід застосувати формулу (1.24) до усіх вузлів j = 2, ... , J-1, припускаючи 
при цьому, що граничні умови Диріхле забезпечують дані про 
значення  Тj

n-1іTj
n+1. 

1.2.7 Порівняння особливостей методів кінцевих елементів та 
граничних елементів 

Моделювання численних фізичних, біологічних і хімічних явищ часто 
приводить до розв’язання лінійних або нелінійних рівнянь, або систем 
рівнянь в частинних похідних. Існують традиційні математичні засоби, що 
дозволяють отримати розв’язок в певних випадках (аналіз Фур'є, 
розкладання в ряд і т. п.), але для вирішення конкретних проблем, що 
виникають в науці і техніці, неможливо обійтися без використання 
чисельних методів. Зі зростанням продуктивності ЕОМ чисельне 
моделювання набуває особливого значення, тому це дозволяє доповнити 
або навіть замінити прямий експеримент. Постановка останнього буває 
трудомісткою або взагалі неможливою (моделювання стійкості дамб, 
землетрусів, дослідження сонячних явищ) [13, 14]. 

Розроблено багато методів чисельного розв’язання рівнянь в частинних 
похідних. Найбільш часто використовувані з них – методи кінцевих 
різниць і кінцевих елементів.  

Метод кінцевих різниць був розроблений раніше за інших і на перший 
погляд є найбільш простим у реалізації. Ідея його полягає в розбитті 
прямокутною сіткою області, в якій розв’язується рівняння, і дискретизації 
диференціального оператора. Розв’язуючи лінійну систему рівнянь, 
знаходять наближені розв’язки у вузлах решітки. Основні труднощі 
пов'язані з урахуванням граничних умов, якщо границя області має 
складну геометричну форму.  

 Перші розробки методу кінцевих елементів (МКЕ) були виконані в  
50-х роках для вирішення завдань опору матеріалів. У 60-і роки 
математики отримали строгі формулювання для цього методу, після чого 
він стає загальним засобом вивчення завдань в частинних похідних, 
потроху витісняючи метод кінцевих різниць, який розглядався в період 
свого апогею як універсальний засіб розв’язання завдань такого типу. 
Після його докладного математичного дослідження виявилося, що при не 
досить коректних вхідних даних задачі МКЕ найчастіше сходиться 
швидше, ніж метод кінцевих різниць, а іноді взагалі має дуже високу 
швидкість збіжності. Починаючи з 1970 р. цей метод стає все більш 
популярним серед інженерів усіх спеціальностей завдяки роботам 
Зінкевича, Галлагера, Одена, Ліона, Равьяра, Сильвестера.  
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 Ще раз коротко зупинимося на зв'язках і порівнянні МКЕ з методом 
кінцевих різниць, цих найбільш поширених та ефективних чисельних 
методах. Побудова кінцево-різницевих схем зазвичай потребує невеликого 
обсягу обчислень, як правило, менших, ніж у МКЕ. Однак перевагами 
МКЕ є гнучкість і різноманітність сіток, стандартні прийоми побудови 
дискретних задач для довільних областей, простота обліку природних 
крайових умов і т.д. Крім того, математичний аналіз МКЕ є більш простим, 
його метод можна застосовувати до більш широкого класу вихідних задач, 
а оцінки похибок наближених рішень, як правило, виходять за менш 
жорсткі обмеження, ніж у методі кінцевих різниць. Разом з тим необхідно 
підкреслити, що основу для дослідження МКЕ створили фундаментальні 
результати, пов'язані з дослідженням збіжності та стійкості кінцево-
різницевих схем, проекційних методів, узагальнених рішень. 
 

Контрольні запитання 
 
1. Критерії теплової подібності. 
2. Умови подібності процесів теплопровідності. 
3. Дайте означення критерія Пекле (Pe). 
4. Переваги та недоліки математичного моделювання теплових 

процесів. 
5. Дайте означення теоретичного та емпіричного підходів із визначення 

зв’язку між вхідними і вихідними змінними математичної моделі. 
6. Опишіть етап постановки завдання. 
7. Опишіть причини нелінійності теплофізичних моделей. 
8. Як здійснюють перевірку адекватності моделі? 
9.Охарактеризуйте класифікації методів розв’язання задач тепло-

масообміну. 
10. Суть методу кінцевих елементів. 
11. Суть методу кінцевих різниць. 
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2 ПРОГРАМНІ ПРОДУКТИ ДЛЯ МОДЕЛЮВАННЯ 
ТЕПЛООБМІННИХ ПРОЦЕСІВ 

2.1  Програмний продукт CosmosWorks Professional 

CosmosWorks – потужний і простий у використанні програмний 
комплекс для проведення інженерних розрахунків. CosmosWorks дозволяє 
вирішувати будь-яке інженерне завдання, він повністю інтегрований в 
SolidWorks, тому розрахунок можна проводити простим підключенням 
модуля. Використовуючи програмні пакети SolidWorks і CosmosWorks, 
користувачі отримують ефективний і недорогий продукт для розв’язання 
своїх задач.  

CosmosWorks має широкий спектр спеціалізованих алгоритмів 
розв’язування, що дозволяє провести аналіз більшості завдань для деталей 
і складань:  

–  лінійний, статичний аналіз;  
–  визначення власних форм і частоти;  
–  розрахунок критичних сил і форм втрати стійкості;  
–  тепловий аналіз;  
–  розрахунок складань з використанням контактних елементів;  
–  нелінійні розрахунки;  
–  оптимізація конструкції;  
–  розрахунок електромагнітних коливань;  
–  визначення довговічності конструкції;  
–  розрахунок потоку рідин і газів. 
Підготовка моделі: 
–  підтримка довільних системних одиниць; 
–  інженерні бази даних за властивостями речовин, об'єктів.  
Початкові і граничні умови: 
–  вхідні параметри – швидкість, тиск (статичне, динамічне, 

навколишнє середовище), масова та об'ємна витрата; 
–  температура, концентрація компонентів, параметри турбулентності; 
–  випадково-напірні характеристики віртуальних вентиляторів; 
–  різні види стінок, включаючи шорсткі; 
–  джерела тепла (об'ємні та поверхневі), віртуальні тепловентилятори; 
–  можливість моделювання залежності граничних умов, параметрів   

часу та координат; 
–  симетрія відносно базових площин і періодична симетрія. 
Розрахункова сітка і керування процедурою обчислення: 
–  генерація розрахункової сітки безпосередньо за моделлю SolidWorks; 
–  автоматичне створення розрахункової області та генерація сітки в 

області твердого тіла і області потоку; 
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– автоматична адаптація сітки залежно від геометричних
характеристик моделі і поля розв’язку; 

– визначення цілей моделювання (параметрів, що цікавлять, на
поверхнях або в об’ємах) та їх моніторинг під час розрахунку; 

– можливість попереднього перегляду полів потоку в заданих
перетинах без зупинки розрахунку; 

– критерії автоматичної зупинки розрахунку.
Можливості моделювання: 
– стаціонарні та нестаціонарні потоки;
– потоки, які стискаються і не стискаються (рідини або гази),

включаючи надзвукові режими; 
– ідеальні та реальні гази;
– неньютонівські рідини;
– одно- і багатокомпонентні потоки без хімічної взаємодії та

розділення фаз; 
– спільний розрахунок потоку рідини або газу і теплопередачі

всередині твердого тіла без наявності границі поділу газ-рідина; 
– ламінарні і турбулентні потоки, облік ламінарного і турбулентного

переходу; 
– "заморожування" потоку для розподілу "швидких" і "повільних"

процесів; 
– потоки в пористих середовищах з урахуванням теплопровідності

стінки; 
– зовнішній або внутрішній потік;
– конвективний теплообмін, вільна, вимушена або змішана конвекція;
– радіаційний теплообмін з керуванням прозорістю стінок і розподілом

властивостей стінок для моделювання теплообміну 
випромінюванням і сонячної радіації; 

– розрахунок траєкторій твердих частинок і крапель в потоці;
– можливість розрахунку двовимірного (2D) завдання;
– теплові елементи Пельтьє.
Результати: 
– результати виводяться у вікні SolidWorks;
– виведення функції на будь-якій площині або поверхні у вигляді

кольорових ескізів, векторів і ізоліній, відображення результатів за 
допомогою ізоповерхонь; 

– інтегральні характеристики на довільній грані або сукупності граней;
– створення тривимірних траєкторій;
– виведення характеристик розрахунку в MS Excel;
– розподіл будь-якої характеристики уздовж будь-якої кривої та

передача в MS Excel; 
– анімація результатів;
– розрахунок характеристик у точках, що визначаються користувачем;
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– виведення основних розрахункових та інтегральних величин в MS
Excel; 

– автоматичне створення звіту;
– передача тиску на стінках, коефіцієнтів тепловіддачі і температур в

SolidWorks Simulation. 

2.2  Програмний комплекс ТріАНА-2.00 

Програмний комплекс ТріАНА є складовою частиною системи 
АСЗНЯА (автоматизована система забезпечення надійності і якості 
апаратури) і призначений для аналізу теплових характеристик конструкцій 
радіоелектронної апаратури (стояків, крейтів, блоків, друкованих вузлів, 
функціональних елементів, мікроскладань) на ранніх етапах проектування. 
Програмний комплекс розрахований на інженерів-конструкторів 
промислових підприємств, що займаються розробкою радіоелектронної 
апаратури (РЕА).  

Метою моделювання є отримання даних про теплові поля конструкцій 
РЕА 3-го і 4-го рівнів конструктивної ієрархії (температур конструктивних 
вузлів, елементів і потоків холодоносія в мережі каналів конструкції 
стояка, крейта чи блока), теплових полів конструктивних вузлів 2-го рівня 
конструктивної ієрархії (теплових полів основних функціональних 
комірок, друкованих плат, підкладок, температур активних зон і корпусів 
електрорадіоелементів).  

Складові частини «ТріАНА» : 
1. MTPEditor ТріАНА – графічний редактор топологічних моделей

теплових процесів, що дозволяє: 
– формувати конструкції РЕА з параметричним описом їх компонентів,

що використовують геометричні і теплофізичні параметри 
графічних образів використовуваних вузлів та конструкцій РЕА в 
цілому;  

– відображати результати моделювання безпосередньо на топологічній
моделі теплових процесів; 

2. BoardEditor – графічний редактор конструкцій РЕА типу
«друкований вузол»,  який дозволяє створювати геометричні моделі 
конструкцій з позицій дослідження в них теплових процесів; вести 
базу даних; відображати результати моделювання на геометричній 
моделі досліджуваного конструктивного вузла, в тому числі на 3D-
моделі;  

3. Conv2Triana – конвертор друкованих плат, що реалізовує функції
автоматичного перетворення основних параметрів переносної 
конструкції, а також схеми розміщення елементів на програмний 
комплекс з форматів систем топологічного проектування 
друкованих плат (PCAD, ACCEL, PROTELDXP та ін.) у формат ПК 
ТріАНА;  
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4. Triana – математичне ядро, що включає до свого складу набір
спеціалізованих програм, що реалізують функції автоматичного 
синтезу моделей теплових процесів конструктивних вузлів РЕА на 
основі їх геометричної моделі і температурних умов їх експлуатації 
(граничні та початкові умови);  

5. Набір модулів, що виконують функції:
– формування математичних моделей для моделювання теплових

процесів досліджуваної конструкції РЕА в стаціонарному і 
нестаціонарному режимах;  

– аналізу математичної моделі, яка може бути сформована у вигляді
системи лінійних алгебраїчних рівнянь, системи нелінійних 
алгебраїчних рівнянь або системи звичайних диференціальних 
рівнянь;  

– бібліотеку аналітичних моделей для аналізу різних видів теплообміну
та їх модифікацій (у бібліотеці міститься близько 70 розділів). 

Перераховані компоненти програмного комплексу ТріАНА можуть 
працювати як автономно, так і компонуватись в групи.   

Відмінні особливості 
Облік у моделях:  
– багатошарові конструкції друкованих плат і функціональні комірки;

вирізи теплових шин; 
– контури з теплових шин;
– системи з кондуктивних теплостоків;
– локальні умови охолодження;
– різні варіанти установлення радіоелементів на переносних

конструкціях.  
У цілому ТріАНА дозволяє вирішувати такі завдання: 
– визначення теплових режимів роботи великої кількості

радіоелементів і переносних конструкцій з урахуванням 
конструктивно-технологічних та експлуатаційних особливостей 
РЕА різного призначення (авіаційна, космічна, морська, 
автомобільна та інша РЕА); 

– внесення змін у конструкцію з метою забезпечення необхідного (з
точки зору електричних характеристик або показників надійності) 
теплового режиму роботи РЕА;  

– вибір кращого варіанта конструкції РЕА з декількох наявних з точки
зору теплових характеристик; 

– обґрунтування необхідності додаткового захисту РЕА від
температурних впливів; 

– створення ефективної програми випробувань РЕА на тепловий
вплив (вибір параметрів випробувальної дії, найбільш зручне 
розташування місць установлення реєструвальних датчиків). 
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2.3  Програмний продукт MSC.Nastran  

MSC.Nastran забезпечує повний набір розрахунків, включаючи 
розрахунок навантажено-деформованого стану, власних частот і форм 
коливань, аналіз стійкості, розв’язання задач теплопередачі, дослідження 
сталих і несталих процесів, акустичних явищ, нелінійних статичних 
процесів, нелінійних динамічних перехідних процесів, розрахунок 
критичних частот і вібрацій роторних машин, аналіз частотних 
характеристик при впливі випадкових навантажень, спектральний аналіз і 
дослідження аеропружності. Передбачена можливість моделювання 
практично всіх типів матеріалів, включаючи композитні і гіперпружні. 
Розширені функції включають технологію суперелементів 
(підконструкцій), модальний синтез і макромова DMAP для створення 
користувацьких додатків. 

Поряд з розрахунком конструкцій MSC.Nastran може 
використовуватися і для оптимізації проектів. Оптимізацію можна 
проводити для задач статики, стійкості, сталих і несталих динамічних 
перехідних процесів, власних частот і форм коливань, акустики і 
аеропружності. І все це робиться одночасно шляхом варіації параметрів 
форми, розмірів і властивостей проекту. Завдяки своїй ефективності 
алгоритми оптимізації обробляють необмежену кількість проектних 
параметрів і обмежень. Вага, напруга, переміщення, власні частоти і багато 
інших характеристик можуть розглядатися або як цільові функції проекту 
(в цьому випадку їх можна мінімізувати або максимізувати), або як 
обмеження. Алгоритми аналізу чутливості дозволяють досліджувати вплив 
різних параметрів на поведінку цільової функції і керувати процесом 
пошуку оптимального розв’язку.  

Широкі можливості функції оптимізації MSC.Nastran дозволяють 
використовувати його для автоматичної ідентифікації комп'ютерної 
розрахункової моделі і експерименту. Цільова функція визначається у 
вигляді мінімізації неузгодженості результатів розрахунків і експерименту, 
змінними параметрами вибираються найменш достовірні розрахункові 
параметри конструкції. Як результат оптимізації MSC.Nastran видає нову 
комп'ютерну модель, яка повністю відповідає експериментальній моделі.  

Програма  також включає унікальну функцію оптимізації конструкції з 
необмеженими змінами її геометричної форми (вимірювання геометричної 
топології об'єкта) при мінімізації ваги і відповідності граничним умовам за 
міцністю. Ця функція дозволяє виконувати автоматичне проектування 
силових схем конструкцій, коли на основі об'ємної масивної заготовки 
автоматично створює ажурну оптимальну конструкцію, яка максимально 
задовольняє задані умови. Застосовується MSC.Nastran також і для 
планування експериментів (визначення місць розташування датчиків) та 
оцінювання повноти отриманих експериментальних даних.  

37 



 

За допомогою MSC.Nastran вирішуються також задачі моделювання 
систем управління, систем терморегулювання з урахуванням їх впливу на 
конструкцію.  

На основі можливостей автоматичного перезавантаження в 
MSC.Nastran проводяться складні багатокрокові дослідження роботи 
конструкції як при зміні умов навантаження, граничних умов і будь-яких 
інших параметрів конструкції, так і при переході від одного виду аналізу 
до іншого. 

2.4  Програмне забезпечення із імітаційного моделювання роботи 
пристрою охолодження РЕА з використанням плавких речовин 
StefanModel 

Призначення та область застосування: програмне забезпечення, 
призначене для моделювання фізичних процесів, що відбуваються в 
пристроях охолодження на основі плавких речовин. З його допомогою 
можна підібрати оптимальний тепловий режим на етапах схемотехнічного 
проектування. Дане програмне забезпечення призначене для використання 
в вищих навчальних закладах, у рамках навчальної програми яких 
передбачено вивчення теплових характеристик і режимів роботи. 

Основні можливості програми:  
–  дозволяє отримати залежність температури джерела від одиничного 

імпульсу, від періодичної послідовності імпульсів;  
–  дозволяє вносити в свою базу нові матеріали робочих речовин 

(потрібно введення основних теплофізичних параметрів матеріалів);  
–  мінімальне введення вихідних даних (початкові умови, фізичні 

параметри, що визначають конструкцію, параметри імпульсу), 
оскільки більшість вже включені в програму, що позбавляє 
користувача від додаткового пошуку необхідних для розрахунку 
даних;  

–  графічне подання результатів розрахунків;  
–  збереження і друк отриманих результатів. 
Основні переваги: 
–  наочність отриманих результатів моделювання;  
–  заміна окремих етапів проведення натурних експериментів на  

фізичній моделі, проведенням обчислювального експерименту на 
математичній моделі;  

–  підвищення надійності за рахунок забезпечення нормальних 
теплових режимів;  

–  зниження витрат при проведенні проектних робіт. 
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2.5  COMSOL Multiphysics 

COMSOL Multiphysics – це потужне інтерактивне середовище для 
моделювання та розрахунків більшості наукових та інженерних задач, 
основаних на диференціальних рівняннях з частковими похідними(PDE), 
методом кінцевих елементів. З цим програмним пакетом ви можете 
розширювати стандартні моделі, використовуючи одне диференціальне 
рівняння (прикладний режим) в мультифізичній моделі для розрахунку 
пов'язаних між собою фізичних явищ. 

Робота програми базується на розв’язанні  системи диференціальних 
рівнянь з частинними похідними. Існує три математичних способи задання 
таких систем:  

– коефіцієнтна форма, призначена для лінійних і близьких до лінійних
моделей; 

– генеральна форма – для нелінійних моделей;
– слабка форма – для моделей з PDE на границях, ребрах або для

моделей, які використовують умови з похідними за часом. 
Використовуючи ці способи, можна змінювати типи аналізу, 

включаючи:  
– стаціонарний і перехідний аналіз;
– лінійний та нелінійний аналіз;
– модальний аналіз і аналіз власних частот.
Для розв’язання PDE використовується метод кінцевих елементів. 

Програмне забезпечення запускає кінцевий аналіз разом з сіткою, що 
враховує геометричну конфігурацію тіл, і контролем похибок з 
використанням різноманітних чисельних рішень. Оскільки багато фізичних 
законів виражаються в формі PDE, стає можливим моделювати широкий 
спектр наукових та інженерних явищ з багатьох областей фізики, таких як: 
акустика, хімічні реакції, дифузія, електромагнетизм, гідродинаміка, 
фільтрування, тепломасообмін, оптика, квантова механіка, 
напівпровідникові пристрої, опір матеріалів та багатьох інших.  

Крім перерахованого вище, за допомогою зміни зв'язку програма 
дозволяє поєднувати моделі в різних положеннях і пов'язувати між собою 
моделі різних розмірів. Для створення та розрахунку завдання 
рекомендується така послідовність дій: 

1. Вибираємо розмірність моделі, визначаємо фізичний розділ в
ModelNavigator [Навігатор моделей] (кожному розділу відповідає певне 
диференціальне рівняння) і визначаємо стаціонарний або нестаціонарний 
аналіз температурного поля; 

2. Визначаємо робочу область і задаємо розміри;
3. Задаємо вихідні дані, залежності змінних від координат і часу;
4. Зазначаємо теплофізичні властивості та початкові умови;
5. Зазначаємо граничні умови ;
6. Задаємо параметри і будуємо сітку;
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7.Визначаємо параметри розв’язувального пристрою і запускаємо 
розрахунок; 

8. Налаштовуємо режим відображення; 
9. Отримуємо результати. 

2.6  Віртуальний проектувальник Webench від компанії National 
Semiconductor 

WEBENCH – це безкоштовна інтерактивна програма, яка прискорює 
проектування за допомогою вибору компонентів, електричної симуляції, 
віртуального розведення та компонування елементів на платі, а також 
термічної симуляції схем. WEBENCH  інтегрований з системами он-лайн 
замовлень багатьох постачальників електронних компонентів, що дозволяє 
розробнику замовляти набори для макетування свого конкретного проекту 
або повністю складені і перевірені плати. При роботі з WEBENCH відпадає 
необхідність тривалого пошуку компонентів з переглядом посібників з 
вибору, специфікацій та інструкцій із застосування. Обчислення 
проводяться автоматично. Параметри компонентів інтегровані в засоби 
електричного аналізу. Користувач має миттєвий доступ до Spice-моделей, 
параметричних даних та інформації про корпуси. Все це дозволяє 
скоротити час проектування з декількох тижнів до декількох годин, 
скорочуючи тим самим витрати на розробку. 

На сьогодні WEBENCH  містить засоби для розробки та симуляції схем 
операційних підсилювачів, аудіопідсилювачів, активних фільтрів, джерел 
живлення, схем ФАПЧ і мікроконтролерів. Крім електричної симуляції 
секція з джерел живлення містить термічний симулятор WebTHERM, що 
дозволяє розраховувати площу металізації плати, розміри радіаторів і 
швидкість потоку повітря вентиляторів обдування схем живлення.  

Для прикладу розглянемо проектування неізольованого 
понижувального джерела живлення за допомогою Power Webench. 
Діапазон вхідної напруги нашого джерела повинен знаходиться в межах 
від 10 до 36 В, а його вихід повинен підтримувати роботу з навантаженням 
до 4 А при напрузі в 5 В. На стартовій сторінці Power Webench вносимо 
електричні параметри джерела і температуру навколишнього середовища, 
при якій будемо проводити температурну симуляцію роботи схеми, потім 
натискаємо кнопку "Show Recommended Power Management ICs". Програма 
переносить нас на наступну сторінку, де пропонується список 
компонентів, можливих для застосування при заданих параметрах. Після 
того, як ми вибрали контролер живлення, натискаємо на клавішу "Create 
Design". Тепер у нас є готова електрична схема джерела і її робочі 
характеристики, список зовнішніх компонентів із зазначенням їх 
параметрів і фірм-виробників, кожний з яких можна при бажанні замінити.  

Наступний крок – аналіз. Power Webench містить два типи симуляції – 
електричну та температурну. Щоб потрапити на сторінку аналізу, 
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вибираємо пункт 3 вгорі вікна веб-браузера "Analyze a Design". Тут ми 
можемо замовити в програмі нарисувати діаграму  для аналізу амплітудно-
частотного відгуку схеми, форми сигналів при перехідних процесах і т. д. 
Для цього в лівому верхньому кутку вікна вибираємо тип симуляції і 
клацаємо мишкою на кнопку "Start New Simulation". Висхідне вікно 
покаже результати симуляції. Те ж саме робимо для проведення 
термічного аналізу, вибираючи вгорі сторінки пункт "Thermal Simulation". 

Результати термічної симуляції виводяться у вигляді картинки 
друкованої плати, де різними кольорами позначається температура нагріву 
областей плати. Якщо ці результати нас не задовольняють, є можливість 
заміни вхідних параметрів, таких як компоненти, температура, повітряний 
обдув, площа металізації і т. д. За необхідності додаємо радіатор і 
проводимо нову симуляцію.  

Проекти зберігаються на сервері в безпечному місці, і можуть бути 
переглянуті і змінені в будь-який час. Кожен проект комплектується 
документацією.  

2.7  Порівняння характеристик програм для термомоделювання 

Наведені основні характеристики універсальних закордонних програм і 
їх порівняння з точки зору простоти використання та спектра можливостей 
для моделювання тепломасообміну, дають можливість користувачеві 
швидко і зручно змоделювати ту чи іншу схему. Оцінення програм 
зроблено на підставі досвіду практичної роботи (табл. 2.1).  

Сумарна оцінка (як сума всіх виставлених оцінок) дає загальне 
уявлення про програму в цілому.  

На підставі оцінок можна зробити висновок, що найбільш потужними, 
універсальними програмами, тобто тими, що дозволяють моделювати 
велику кількість теплообмінних процесів, можна вважати: COMSOL 
Multiphysics,ТріАНА, Thermal desktop. 

Результати проведення порівняння та аналізу програмних продуктів 
зведені в таблицю (табл. 2.1), оцінювання в якій здійснювалось за 
п’ятибальною шкалою. 
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Таблиця 2.1 – Порівняльна характеристика програм для 
термомоделювання. Оцінювання ведеться за 5-ти бальною шкалою. Де 5 – 
означає найефективніше використання в даній області 

Критерій 
порівняння 

Програми 

C
os

m
os

W
or

ks
 

W
eb

en
ch

 

Тр
іА

Н
А

 

M
SC

.N
as

tra
n 

St
ef

an
M

od
el

 

C
O

M
SO

L 
M

ul
tip

hy
si

cs
 

Th
er

m
al

 d
es

kt
op

 

Простота 
використання 4 5 3 2 4 2 3 

Наочність подання 
інформації  4 3 4 4 5 5 5 

Наявність макро- 
мови  + – – – – + + 

Моделювання 
комплексу РЕА 5 3 5 4 3 3 – 

Графічний 
редактор 
топологічних 
моделей теплових 
процесів 

– – + + – + – 

Графічний 
конструктор РЕА – + + + + + – 

Оптимізація 
моделей 4 – 4 5 – 4 3 

Можливість 
створення власної 
бази 

+ – + + + + + 

Якість графічних 
діаграм 4 5 3 4 4 3 4 

Налаштування 
режиму 
відображення  

5 4 5 5 3 4 5 

Підтримка 
електричної 
симуляції 

– + + – – + + 

42 



Продовження таблиці 2.1 

Критерій 
порівняння 

Програми 

C
os

m
os
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ks
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 d
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Підтримка 
інтернет-
замовлення 
компонентів 

– + – – – – – 

Підтримка 
розподілених 
розрахунків 

+ – + – – + – 

Сумісний 
термостатичний 
розрахунок 

5 4 3 4 3 4 5 

Керування 
процесом 
розрахунку 

5 4 4 5 3 5 4 

Зв’язок з іншими 
пакетами 4 2 3 5 3 5 4 

Інтернет-моделі 4 5 2 3 2 5 3 
Загальний рейтинг 
ефективності 
програми (1 – 
перше місце, 7 – 
останнє) 

2 5 7 3 6 1 4 

Контрольні запитання 
1. Охарактеризуйте програмний продукт CosmosWorks Professional.
2. Які можливості моделювання надає програмний комплекс ТріАНА?
3. Які особливості програмного продукта MSC.Nastran 2004?
4. Опишіть можливості програми StefanModel.
5. Які задачі дозволяє вирішувати програмне середовище MSOL

Multiphysics? 
6. Які типи аналізу можна застосувати в MSOL Multiphysics?
7. Назвіть послідовність дій зі створення завдання в MSOL

Multiphysics. 
8. Особливості використання віртуального проектувальника Webench

від компанії National Semiconductor. 
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3 ОПИС ІНТЕРФЕЙСУ ПРОГРАМИ THERMAL DESKTOP 

Цей розділ забезпечує короткий огляд інтерфейсу користувача (user 
interface) THERMAL DESKTOP, який деталізується іконками, меню і різними 
елементами головного вікна AUTOCAD. Якщо THERMAL DESKТOP 
вбудований в AUTOCAD, то в програмі, що запустилася, ви побачите меню 
THERMAL. 

 

 
 

Рисунок 3.1 – Зображення вікна AUTOCAD з вбудованим  
THERMAL DESKТOP 

 
На рисунку 3.1 зображений початковий стандартний екран. Меню 

THERMAL містить всю командну специфіку до THERMAL DESKТOP. Інші 
варіанти меню, певні положення у меню містять команди, створені AUTOCAD, 
багато з яких – стандартні команди Windows.  

Як і у інших базових системах Windows, більшість із зазвичай 
використовуваних команд меню пов'язані із панеллю інструментів (toolbar) та 
іконками, які відповідають певним командам меню. 

Панелі інструментів забезпечують швидкий вибір, щоб споживач виконував 
команди швидше. Немає ніякої різниці між використанням «pulldown» меню і 
використанням іконок панелі інструментів, щоб виконувати команди. 

Панелі інструментів об'єднуються в три групи. 
–  Панелі інструментів, зліва від екрана, використовуються для створення 

об'єктів як, наприклад, поверхні, точки розгалуження, проміжні 
з’єднання і т. д. 

–  Панелі інструментів, справа від екрана, використовуються, щоб 
редагувати об'єкти. 
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–  Панелі інструментів, зверху екрана, використовуються, щоб відкривати та 

зберігати  файли, а також для «rotate/pan/zoom» виглядів. 
Щоб побачити, що означає кожна іконка на панелі інструментів, потрібно 

помістити курсор над іконкою. Коли паузи курсора над іконкою короткі, 
текстовий опис іконки не відкривається. 

У нижній лівій ділянці знаходиться іконка UCS (Установлення Координати 
Користувача). Іконка може знаходиться в 2D і 3D зображенні (View> Display> 
UCS Icon> Properties). 

Також визначається координатна сітка (grid)(X, Y або X, Y, Z). Коли 
курсор переміщається в область креслення, координати змінюються, оскільки 
курсор рухається. Ця модифікація може бути дуже зручною при відборі точок 
на екрані. 

Нижнє поле вікна, показаного на рисунку 3.1, є командним рядком, в якому 
користувач може задавати команди і різні значення, а також читати допоміжні 
повідомлення. Якщо в командному рядку видно тільки останні повідомлення, 
то проглянути їх всі можна при натисканні клавіші «F2». 

1. Після натискання «F2» відкриється Thermal Desktop Text Window. 
Використовуйте це вікно, щоб слідкувати за командами і діями, які 

виконуються в поточній сесії. 
2. Після повторного натискання «F2» вікно закриється. 
На рисунку 3.2 зображені Панелі інструментів в AutoCAD/THERMAL 

DESKТOP. 
 

Область командного рядка

Висхідна підказка

Нисхідне меню кольорів Нисхідне меню теплотиНисхідне меню шарів

Напрямні точки

Іконки для редагування 
і керування тим, що 
відображається в 
робочій області екрана

Іконки для 
створення проекта

 
 

Рисунок 3.2– Панелі інструментів в AutoCAD / THERMAL DESKТOP 
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3.1  Основні принципи роботи THERMAL DESKТOP 

3.1.1  Створення прямокутника 

Цей розділ описує деякі загальні функції THERMAL DESKТOP. 

1. У меню з лівого боку екрана виберемо іконку  

2.  або Thermal> Surfaces/Solids > Rectangle 
Команда: _RcRectangle 
У командному рядку з'явиться позначення точки <0.0.0>. 
3. Послідовно клацнемо ще двічі в різних місцях, що визначатиме 

положення вершин проектованого прямокутника (rectangle). 
Створюємо  довільний прямокутник. Фактично координати не важливі. 

Картина повинна вийти подібною тій, що показана на рисунку. 
4. Поверхні поділу прямокутника показано суцільними лініями, а коло 

всередині – точками розгалуження (junction) прямокутника. 
Після того, як задано всі точки, з'явиться діалогове вікно Thermal Model 

Data, яке зображене на рисунку 3.3. 
 

 
 

Рисунок 3.3 – Діалогове вікно Thermal Model Data 
 

5. Виберіть OK, щоб закрити діалогове вікно без змін. 
Прямокутник створено. 
Розглядаючи прямокутник, бачимо суцільні лінії по його периметру 

(circumfery, perimeter), в центрі прямокутника – точка розгалуження і лінії, що 
йдуть від сторін прямокутника до точки (можуть бути видимі і невидимі). Лінії 
йдуть до точки, вказуючи її розташування, що видно з рисунка 3.4. 
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Рисунок 3.4 – Створення прямокутника 
 

Прямокутник має внутрішні лінії (internal lines), які показують 
розташування точки розгалуження. 

У командному рядку вводимо  LTSCALE. З'явиться запит на введення 
нового масштабного коефіцієнта (scale factor), який відповідає за число точок, 
по яких будується внутрішня лінія. Якщо ввести число від 0 до 1, кількість 
точок збільшиться, більше 1 – зменшиться. 

3.1.2  Маркери 

Цей розділ команд демонструє використання маркерів (token) для 
редагування поверхні. Редагування маркерів забезпечує безпосереднє 
редагування об’єктів без використання будь-яких команд в командному рядку. 
Редагування маркерів – швидкий і легкий шлях змінити об'єкт. 

Якщо виділити об’єкт мишею, суцільні лінії зміняться на пунктирні і 
маркери (маленькі квадрати) стають видимими. Колір маркерів за 
замовчуванням є синім, але його, а також розміри маркерів, можна змінювати, 
відкривши меню Tools > Options... і натиснувши закладку Selections, як 
показано нижче. 

Маркери забезпечують просту форму редагування об’єктів і зображені на 
рисунку 3.5. 
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Рисунок 3.5 – Вигляд вікна для редагування маркерів. 
 

1. Запустимо Thermal Desktop і створимо прямокутник, як показано в 
попередньому пункті. 

2. Натиснемо курсором мишки на одній із сторін прямокутника. Суцільні 
лінії зміняться на штрихові та з’являться маркери у різних точках 
прямокутника. 

3. Розмістимо курсор біля одного з маркерів. Курсор зафіксується на 
ближньому маркері. Поставимо  курсор на кінець осі Х квадрата, як показано на 
рисунку 3.5, це дозволить змінювати його розмір по осі Х.  

4. Викличемо контекстне меню, натиснувши правою клавішею миші на 
маркер. Меню дозволяє змінювати розмір і колір маркерів. 

5. Перемістимо курсор на іншу точку та натиснемо клавішу мишки. 
6. Спостерігаймо за змінами прямокутника. 
7. Натиснемо <Ctrl><Z>, щоб відмінити операцію. Прямокутник 

повернеться до свого попереднього вигляду. 
Примітка. Клавіша <Esc> може також використовуватися, щоб зняти 

виділення об'єкта. 
8. Помістимо курсор на інших маркерах, щоб переглянути повідомлення, 

які з’являться біля курсора. 
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3.1.3  Способи виділення об'єктів 

Виділення об'єктів – можливо найважча операція, яка виникає при роботі з 
програмою CAD, і цей пункт пояснить деякі основні поняття, що стосуються 
вибору елементів. 

Є два види виділення: попереднє та кінцеве. 
–  Попереднє (preliminary)  виділення означає, що виділено один або 

декілька об'єктів, а потім запущено якусь команду, наприклад Thermal > 
Edit або Modify > Copy. 

–  Кінцеве (finite) виділення означає, що спочатку запущено команду, а потім 
відбувається вибір одного або декількох об’єктів. Форма курсора 
змінюється і програма чекає, поки користувач вибере об’єкти, яких має 
стосуватись запущена команда. Кінцеве виділення працює, якщо до 
запуску команди не виділений жоден об’єкт.  

Найлегший шлях переконатися, що нічого не виділено перед тим, як 
запустити команду, – натиснути клавішу <Esc>. 

Курсор зображається у вигляді хреста з квадратом посередині (зоною 
вибору) і називається pick box. Для вибору об’єкта, курсор поміщують над 
елементом, який потрібно вибрати, і усі елементи, які потрапили в зону вибору, 
будуть виділені після натиснення клавіші миші. 

Коли курсор зупиняється біля об’єкта, який потрібно вибрати, поряд з його 
краєм виникає підказка, яка характеризує об’єкт. У підказці вказано вид та 
формат (format :OBJECTID) об’єкта, який є різним для кожного об’єкта. 

Розмір зони вибору можна змінити, надрукувавши PICKBOX в 
командному рядку і змінивши вхідне значення. Значення за замовчуванням 3 
часто дуже маленьке, щоб бути корисним; багато споживачів віддають перевагу 
значенню 5. 

Існує декілька методів вибору елементів: можна вибирати елемент, навівши 
на нього курсор та натиснувши клавішу миші, можна вибирати окремі елементи 
з допомогою миші та натиснутої клавіші <Ctrl>. Якщо потрібно вибрати групу 
елементів, їх усіх можна виділити, натиснувши клавішу миші та створивши 
прямокутник навколо потрібних елементів, що може зекономити час порівняно 
з окремим вибором. 

3.1.4  Команди Pan, Zoom, Rotate таViews 

Цей розділ демонструє декілька методів заміни вигляду на екрані. Вигляд 
може бути наближений або віддалений для кращого перегляду. Вигляд може 
бути змінений шляхом переміщення об’єктів вверх, вниз, вправо або вліво без 
використання збільшення або зменшення. Зміна вигляду може допомогти 
користувачеві створювати нові деталі. 

1. Запустіть Thermal Desktop і створіть прямокутник, як показано в 
попередньому пункті. 
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2. Натисніть  або View > Zoom > Realtime. Курсор набуде вигляду 
відповідного значка. 

3. Натисніть ліву клавішу миші та переміщуйте курсор вверх та вниз, що 
відповідатиме збільшенню та зменшенню зображення, відповідно. 

4. Коли підберете потрібний розмір об’єкта, натисніть праву клавішу миші 
та виберіть команду Exit для завершення операції. 

Дану операцію можна також виконувати за допомогою командного рядка. 

Натисніть  або View > Pan > Realtime. Курсор прийме вигляд 
відповідного значка. Затиснувши клавішу миші та рухаючи курсором, можна 
переміщати усі зображення, які знаходяться на робочому столі, у будь-якому 
напрямку. Відмінити операцію можна з допомогою клавіші <Esc> або Exit. 
Дану операцію можна також виконувати з допомогою командного рядка. 

Натисніть  або View > Zoom > Extents. Усі переміщені, збільшені або 
зменшені об’єкти розміщуються на робочому столі, займаючи максимальну 
його площу. Відмінити операцію можна за допомогою клавіші <Esc> або Exit. 
Дану операцію можна також виконувати за допомогою командного рядка. 

Натисніть  або View > Zoom > Window. За допомогою даної команди 
виділяється частина об’єкта та збільшується таким чином, щоб виділений 
фрагмент займав максимальну площу робочого столу. Відмінити операцію 
можна за допомогою клавіші <Esc> або Exit. Дану операцію можна також 
виконувати за допомогою командного рядка. 

Натисніть  або View > Zoom > Previous. Команда відміняє 
перетворення, які були створені за допомогою Zoom або Pan, повертаючи 
об’єкту попередній вигляд. Відмінити операцію можна за допомогою клавіші 
<Esc> або Exit. Дану операцію можна також виконувати за допомогою 
командного рядка. 

Натисніть  або View > 3D Orbit. На екрані з’явиться arcball – велике 
коло або сфера з 4 меншими колами на своєму контурі. Помістивши курсор на 
одне з малих кіл та рухаючи його, можна повертати об’єкти у різні сторони 
навколо його осей. Викликавши контекстне меню, можна побачити, що 3D 
Orbit також відповідають команди Zoom, Pal та деякі інші, які можна запустити 
з даного меню. Відмінити операцію можна за допомогою клавіші <Esc> або 
Exit. Дану операцію можна також виконувати за допомогою командного рядка. 

Викличте меню View > 3D Views. Потім виберіть View > 3D Views > SW 
Isometric або View > 3D Views > Top. Дані функції меню дозволять побачити, 
як змінюватиметься положення системи координат залежно від вибраної 
функції. Виберіть якісь інші функції та простежте за зміною положення осей 
координат. 
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Рисунок 3.6 – Меню View > 3D Views 
 

На рисунку 3.6 зображені функції меню View > 3D Views. 

3.1.5  Види Shading/Wireframe 

Команди Shade and Wireframe пропонують користувачеві різні способи 
розгляду моделей. 

Команди Shade and Wireframe знаходяться у меню View > Shade 
Перші три  пункти у меню – 2D Wireframe, 3D Wireframe і Hidden. Різниця 

між ними не досить помітна, але кожен з них має свої особливості. На 
рисунку 3.8 проілюстровано кожен з цих трьох пунктів. 

 

 
 

Рисунок 3.7 – Меню View > Shade 
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Рисунок 3.8 – Вигляди 2D Wireframe, 3D Wireframe і Hidden 
 

Є чотири види штрихування (shading) моделей — Flat Shaded, Gourand 
Shaded (Smooth Shaded), Gourand Shaded, Edges On. З чотирьох методів 
найкращим для перегляду та використання є Gouraud Shaded. 

Іконки панелі інструментів для команд 2D/3D Wireframe, Hidden і Gouraud 
Shaded 

 
На рисунку 3.9 розглянуто приклад об'єкта, для якого використовуються 

команди View > Shade. 
 

 
 

Рисунок 3.9 – Приклади штриховки 

3.1.6  Створення шарів 

Все на рисунку пов'язується з шаром (layer). Шари – окремі області 
креслення, які довершують один одного і використовуються, щоб редагувати і 
маніпулювати кольором, світлотінню (treatment of light and shade) та 
насиченістю об'єкта. Шари є хорошим шляхом для групування і показу зв'язків 
між об’єктами на рисунку. 
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Коли новий об'єкт створений, він розміщується на поточному шарі. 

Властивості шару, як, наприклад, ім'я і колір, редагуються в діалоговому вікні 
Layer Properties Manager, де також знаходяться і інші властивості шарів. 

Вікно Layer Properties Manager показано на рисунку 3.10. Кожна модель має 
нульовий шар. Нульовий шар система створює самостійно і його не можна 
видалити або перейменувати. Інший шар – ASHADE – використовує Autocad 
для управління параметрами освітлення об'єктів. Шар ASHADE закритий. 
Закриті шари не можуть бути змінені. 

Наступний розділ знайомить користувача зі створенням нових шарів та 
вікном Layer Properties Manager. 

1. Запустіть Thermal Desktop і створіть прямокутник, як показано в 
попередньому пункті. 

2. Натисніть   або Format >Layer, або задайте команду Layer у 
командному рядку. 
 

 
 

Рисунок 3.10 – Вікно Layer Properties Manager 
 

Запуститься вікно Layer Properties Manager, що на рисунку 3.10. 
1. Створіть новий шар. 
2. Виберіть іконку, схожу на «лампочку», якщо вона темна – це означає, що 

шар вимкнено. 
3. Змініть колір нульового шару. Виберіть діалогове вікно кольорів та 

виберіть у ньому червоний колір. 
4. Натисніть ОК для того, щоб закрити вікно кольорів. Вікно Layer 

Properties Manager має показати червоний колір у стовпці «Колір», що 
відповідає рядку нульового шару. 
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Рисунок 3.11 – Вікно Layer Properties Manager 
На рисунку 3.11 зображене вікно Layer Properties Manager. 
5. Натисніть ОК для закриття вікна Layer Properties Manager. 
Після виходу з даного меню усі об’єкти на робочому столі змінять свій 

колір на червоний.  
6. Натисніть  або Tools > Properties, або введіть команду «properties» в 

командному рядку, або натисніть<Ctrl><1>. 
 

 
 

Рисунок 3.12 – Діалогове вікно властивостей 
 

З’явиться діалогове вікно властивостей, що зображене на рисунку 3.12. 
1. Виберіть прямокутник на робочому столі. Вікно зміниться, відображаючи 

листок величин, які характеризують виділений прямокутник. 
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Кожен графічний об'єкт має властивості, пов'язані з проектом, деякі з яких 

можуть бути змінені користувачем. Подвійне клацання по об'єкту викличе 
вікно «Властивості». 

2. Відкрийте Layer pulldown menu і виберіть Layer1. Пам’ятайте, що 
Layer1 був вимкнений у Layer Properties Manager. 

3. Натисніть ОК, щоб закрити вікно. Прямокутник на робочому столі стане 
невидимим. 

4. Викличте Layer pulldown menu і ввімкніть Layer1. На екрані знову 
з’явиться прямокутник, але уже білого кольору. 

5. Натисніть X у верхньому лівому кутку екрана, щоб закрити вікно 
властивостей. 

Точно так, як і кожен об'єкт пов’язаний з певним шаром, він також 
асоціюється з певним кольором. Стандартний колір для об'єктів 
встановлюється Color By Layer, який встановлює такий же колір, як і для шару, 
що характеризує даний об’єкт і який обирається у Layer Properties Manager. 

На рисунку 3.13 зображене вікно Color By Layer. 
 

 
 

Рисунок 3.13 – Вікно Color By Layer 
 

Якщо змінювати колір через Color pulldown menu, показане вище, не 
виділяючи об’єкт, то вибраний колір стане стандартним для усіх новостворених 
об’єктів. Якщо змінювати колір, коли вибрано один або декілька об’єктів, то 
колір зміниться лише у вибраних об’єктів. 

3.2  Моделювання за допомогою програми THERMAL DESKTOP 

3.2.1  Приклад побудови друкованої плати 

У цій вправі друкована плата вмонтовуватиметься до алюмінієвої пластини. 
Друкована плата міститиме резистори, підстроювальний резистор, світлодіод та 
транзистори. Установлення елементів на плату необхідно здійснювати 
відповідно до ОСТ 4.010.030-81[18]. 
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Вибір матеріалу для моделювання 
Ця частина вправи визначає термофізичні властивості для матеріалів 

пластини, елементів та плати. 
Стандартними одиницями вимірювання для Thermal Desktop є система 

одиниць СІ. Одиниці, які відповідають деяким властивостям: 
W/m/K – для провідності; 
J/Kg/K – для теплоти; 
kg/m3 – для концентрації. 
Послідовність дій така: 
Спочатку виберіть Thermal > Thermophysical Properties > Edit Property 

Data. 
На рисунку 3.14 зображене вікно Edit Property Data. 

 

 
 

Рисунок 3.14 – Вікно Edit Property Data 
 

1. Виберіть «Aluminum» у «New property to add» 
2. Натисніть кнопку Add. 
З’явиться діалогове вікно Thermophysical Properties 
3. У розділі Conductivity (провідність) у рядку k введіть 237. 
4. У розділі Specific Heat (теплота) меню у рядку ср введіть 900. 
5. У розділі Density (концентрація) рядку rho введіть значення 2702. 
6. Виберіть OK. 
Знову з’явиться вікно Edit Thermophysical Properties, в якому буде 

відображатись рядок з заданим матеріалом та його заданими властивостями. 
7. Надрукуйте fr4 2 oz copper в «New property to add», щоб додати ділянку 

поверхні кристала без компонентів (плата). 
8. Натисніть кнопку Add. 
9. У розділі Conductivity (провідність) у рядку k введіть 17,7. 
10. У розділі Specific Heat (теплота) меню у рядку ср введіть 0. 
11. У розділі Density (концентрація) в рядку rho введіть значення 0. 
12. Виберіть OK. 
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Рисунок 3.15 – Вікно Thermophysical Properties 
 

Знову з’явиться вікно Edit Thermophysical Properties (рисунок 3.15), в якому 
буде відображатись рядок з заданим матеріалом та його заданими 
властивостями. 

13. Надрукуйте Ldiod в «New property to add», щоб додати матеріал для 
світлодіода. 

14. Натисніть кнопку Add. 
15. У розділі Conductivity (провідність) у рядку k введіть 165. 
16. У розділі Specific Heat (теплота) у рядку ср введіть 100. 
17. У розділі Density (концентрація) в рядку rho введіть значення 2000. 
18. Виберіть OK. 
Знову з’явиться вікно Edit Thermophysical Properties.  
19. Надрукуйте PRez в «New property to add», щоб додати матеріал для 

підстроювального резистора. 
20. Натисніть кнопку Add. 
21. У розділі Conductivity (провідність) у рядку k введіть 165. 
22. У розділі Specific Heat (теплота) у рядку ср введіть 500. 
23. У розділі Density (концентрація) рядку rho введіть значення 2500. 
24. Виберіть OK. 
Знову з’явиться вікно Edit Thermophysical Properties. 
25. Надрукуйте Rez в «New property to add», щоб додати матеріал для 

резисторів. 
26. Натисніть кнопку Add. 
27. У розділі Conductivity (провідність) у рядку k введіть 165. 
28. У розділі Specific Heat (теплота) у рядку ср введіть 500. 
29. У розділі Density (концентрація) в рядку rho введіть значення 2500. 
30. Виберіть OK. 
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Знову з’явиться вікно Edit Thermophysical Properties.  
31. Надрукуйте Tranz в «New property to add», щоб додати матеріал для 

транзисторів. 
32. Натисніть кнопку Add. 
33. У розділі Conductivity (провідність) у рядку k введіть 150. 
34. У розділі Specific Heat (теплота) у рядку ср введіть 1000. 
35. У розділі Density (концентрація) в рядку rho введіть значення 1740. 
Виберіть OK. 
36. Виберіть OK для закриття вікна Edit Thermophysical Properties. 
 
Вибір одиниць вимірювання 

1. Натисніть  або Thermal > Preferences. 
З’явиться вікно User Preferences, що зображене на рисунку 3.16.  
 

 
 

Рисунок 3.16 – Вікно User Preferences 
 

2. Виберіть закладку Units у даному вікні. 
Модель має будуватися в дюймах. 
Відмітьте, що величини енергії розраховуються в джоулях, час – у 

секундах, тому установлення норми енергії – вати. 
3. Виключіть меню Model Length та виберіть inch (дюйми) у контекстному 

меню. 
4. Виберіть OK, щоб закрити вікно User Preferences. 
 
Побудова алюмінієвої пластини, яка виконуватиме функції корпусу 

1. Натисніть або Thermal > Surfaces/Solids > Rectangle. 
Команда: _RcRectangle 
2. Надрукуйте 0,0 в командному рядку. 
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Примітка. Пам'ятайте, що потрібно натискати «Enter» після друкування в 

командному рядку. 
3. Надрукуйте 1.48,0 в командному рядку – визначає довжину пластини.  
4. Надрукуйте 0,0.96 в командному рядку – ширина пластини (висота 

корпусу). 
З’явиться вікно Thermal Model Data, що на рисунку 3.17. 

 

 
 

Рисунок 3.17 – Вікно Thermal Model Data (закладка Subdivision) 
 

1. Відкрийте закладку Subdivision. 
2. Знайдіть меню Centered Nodes. 
3. В полі X-direction задайте кількість точок розгалуження по осі Х 

(задайте 6). 
4. В полі Y-direction задайте кількість точок розгалуження по осі Y 

(задайте 5). 
5. Виберіть закладку Cond/Cap. З’явиться нова інформація у меню. 
6. В пункті меню Material виберіть «Aluminum» з pulldown меню. 
7. У полі Thickness (товщина) задайте товщину пластини 0.04. 
8. Виберіть OK, щоб закрити меню Thermal Model Data. 

9. Натисніть  або View > Zoom > Extents. 
В кінці даних операцій рисунок на екрані повинен бути схожим на 

рисунок 3.18. 
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Рисунок 3.18 – Алюмінієва пластина 
 

1. Натисніть   або Thermal > Preferences. 
Прямокутник, показаний в області креслення, ділиться на шість частин 

вздовж осі X і п’ять уздовж осі Y. Є маленькі кола в центрі кожної частини. 
Кола – точки розгалуження. Показ точки розгалуження має бути вимкненим. 

2. Виберіть закладку  Graphics Visibility. 
3. Клацніть на TD/RC Nodes,щоб зняти виділення. 
Ця операція вимикає показ точки розгалуження через меню Thermal. 
Виберіть OK, щоб закрити діалогове вікно User Preferences. 
Точки розгалуження більше не показуються. 
Відзначте, що набагато швидше дану операцію можна виконати за 

допомогою іконки , яка розташована з правої сторони екрана. 
 

Побудова плати 

1. Натисніть  або Thermal > Surfaces/Solids > Rectangle. 
Команда: _RcRectangle. 
2. Надрукуйте 0.04,0.32 в командному рядку. 0.04 – точка відносно 

алюмінієвої пластини (товщина стінки корпусу, з якої починається побудова 
плати). 0.32 – рівень побудови плати відносно алюмінієвої пластини (залежить 
від висоти найвищого елемента). 
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3. Надрукуйте @1.4,0,0 в командному рядку. 
4. Надрукуйте @0,0,1.4 в командному рядку. 
Ця частина створює друковану плату. 
Знак @ говорить програмі, що будуть вводитись дані, які потрібно 

поєднувати з даними, котрі вводились перед цим.  
З’явиться вікно Thermal Model Data. 
5. Виберіть закладку  Cond/Cap. 
 

 
 

Рисунок 3.19 – Вікно Thermal Model Data (закладка Cond/Cap) 
 

На рисунку 3.19 зображене вікно Thermal Model Data (закладка Cond/Cap). 
6. В меню Material виберіть fr4 2 oz copper і задайте товщину шару 

пластини 0,04. 
7. У рядку меню Cond Submodel надрукуйте «Board». 
8. Натисніть на закладці Subdivision. 
Перед тим, як відкриється потрібна закладка, з’явиться вікно із запитанням 

«Чи потрібно додати модель плати в лист проекту?» 
9. Виберіть Так. 
10. Виберіть 5 у полі X-direction. 
11. Виберіть 5 у полі Y-direction. 
12. Відкрийте закладку Numbering. 
З’явиться вікно Numbering, що на рисунку 3.20. 
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Рисунок 3.20 – Вікно Thermal Model Data (закладка Numbering) 
 

13. В полі Submodel виберіть Board. 
14. Відкрийте закладку Contact. 
З’явиться вікно Contact, що на рисунку 3.21. 

 

 
 

Рисунок 3.21 – Вікно Thermal Model Data (закладка Contact) 
 

15. У ділянці Edges активуйте рядок Along X at Y=0 та встановіть величину 
5 у полі W/in/K. 

16. Натисніть OK, щоб закрити Thermal Model Data. 
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Після закінчення моделювання результат має бути схожим на рисунок 3.22. 

Відмітьте, що циліндр, розташований на границі поверхонь, вказує на те, що 
обидві пластини поєднані між собою в даному місці. 

 

 
 

Рисунок 3.22 – Плата з’єднана з алюмінієвою пластиною 
 

17. Виділіть плату. 

18. Натисніть  або надрукуйте Properties у командному рядку. 
Вигляд вікна Properties для плати. 
Натисніть меню Color та змініть колір плати на зелений, також можна 

користуватися меню ByLayer. 
19. Закрийте вікно, натиснувши X. 
 
Побудова резисторів 

1. Натисніть  або Thermal > Surfaces/Solids > Solid Сylindr. 
2. Надрукуйте в командному рядку початкову точку на платі для резистора 

або задайте її, клацнувши по платі на лінії сітки з урахуванням топології. 
Натисніть Enter. 

3. Надрукуйте @0.24,0,0 в командному рядку – довжина елемента. 
4. В наступному полі в командному рядку введіть 0.04 – радіус резистора. 
5. Наступне поле – мінімальний радіус – введіть 0.0. 
6. Далі – початковий кут – введіть 0.0. 
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7. В наступному полі введіть 360.0 – кінцевий кут. 
З’явиться вікно Thermal Model Data. 
8. Відкрийте закладку Numbering. 
9. В позиції  Submodel напишіть Rez. 
10. Відкрийте закладку Cond/Cap. 
Перед тим, як відкриється потрібна закладка, з’явиться вікно із запитанням 

«Чи потрібно додати модель плати в лист проекту?» 
11. Виберіть Yes. 
12. В позиції Cond Submodel виберіть Rez. 
13. В позиції Material виберіть Rez. 
14. Натисніть OK,щоб закрити діалогове вікно. 
Отримаємо резистор на друкованій платі. 
Виділіть резистор та зробіть його синього кольору. 
Для інших двох резисторів такого самого типу здійснюємо ті ж самі 

команди з різницею у виборі початкової точки на платі згідно з топологією. 
15. Виділіть один з резисторів. 
16. Натисніть  Modify > Move. 
Ця команда показує зміщення резистора відносно плати. 
17. Клацніть на одній з точок резистора, яка при наведенні на неї курсора 

перетворюється на жовтий квадратик (в цьому і наступних випадках для цієї 
операції). 

 
Приєднання резисторів 
1. Надрукуйте @0, 0.06,0 в командному рядку. 
Резистор відділиться від друкованої плати. 
Відстань, на яку віддаляється резистор відносно плати має бути рівною 

половині суми товщини друкованої плати (0,04) і резистора (0,08), яка дорівнює 
0,06.  

Здійсніть таку саму операцію з іншими резисторами. 

2. Натисніть   або Thermal > FD/FEM Network > Contactor. 
3. Виберіть резистор. 
4. Натисніть «Enter». 
5. Виберіть плату. 
6. Натисніть «Enter». 
Резистор повинен приєднатись до плати.  
З’являється діалогове вікно Contactor, що на рисунку 3.23. 
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Рисунок 3.23 – Діалогове вікно Contactor 
 

7. В рядку Conductor Submodel обираємо REZ. 
8. В рядку Conduction Coefficient обираємо 5. 
9. Натискаємо OK, щоб закрити діалогове вікно Contactor. 
З’явиться графічне зображення стрілок, які показують: 
• сторону резистора, протилежну платі, – зелена стрілка; 
• сторону резистора, яка контактує з поверхнею плати, – золота стрілка. 
Попередні операції повторюються для інших резисторів. 
Після закінчення цих операцій результат має бути схожим на рисунок 3.24. 

 

 
 

Рисунок 3.24 – Приєднання резисторів 
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Побудова підстроювального резистора 

1. Натискаємо , або Thermal > Surfaces/Solids > Solid Brick. 
2. Набираємо в командному рядку координати початкової точки на платі, 

для підстроювального резистора також її можна задати, клацнувши по платі на 
лінії сітки з урахуванням топології. Натискаємо Enter. 

3. Вводимо @0.4,0,0 в командному рядку – довжина елемента. 
4. В наступному полі  в командному рядку вводимо @0,0.4,0 –висота 

підстроювального резистора. 
5.Вводимо 0.25. Це ширина елемента. 
З’явиться вікно Thermal Model Data. 
6.Відкриваємо закладку Numbering. 
7.В позиції Submodel напишемо РRez. 
8. Відкриваємо закладку Cond/Cap. 
Перед тим, як відкриється потрібна закладка, з’явиться вікно із запитанням 

«Чи потрібно додати модель плати в лист проекту?» 
9. Вибираємо Yes. 
10. В позиції Cond Submodel вибираємо РRez. 
11. В позиції Material вибираємо РRez. 
12. Натискаємо OK, щоб закрити діалогове вікно. 
Отримаємо підстроювальний резистор на друкованій платі. 
Виділяємо побудований елемент, зробивши його жовтого кольору. 
13. Виділяємо підстроювальний резистор. 
14. Натискаємо Modify > Move. 
15. Клацаємо на одній з точок підстроювального резистора. 
16. Друкуємо @0, 0.04,0 в командному рядку. 
Резистор підніметься над поверхнею друкованої плати. 
 
Приєднання резистора до плати тепловою провідністю 

Натискаємо   або Thermal>FD/FEMNetwork>Contactor. 
1. Вибираємо підстроювальний резистор. 
2. Натискаємо «Enter». 
3. Вибираємо плату. 
4. Натискаємо «Enter». 
Резистор повинен приєднатись до плати.  
З’являється діалогове вікно Contactor. 
5. В рядку ConductorSubmodel вибираємо РREZ. 
6. В рядку Conduction Coefficientвибираємо 5. 
7. Натискаємо OK, щоб закрити діалогове вікно Contactor. 
Як тільки зміни були зроблені, натискаємо OK. З’явиться графічне 

зображення стрілок.  
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Побудова світлодіода 

1. Натискаємо  або Thermal> Surfaces/Solids > Solid Сylindr. 
2. Друкуємо в командному рядку початкову точку на платі для світлодіода 

або задаємо її, клацнувши по платі на лінії сітки з урахуванням топології. 
Натискаємо Enter. 

3. Друкуємо @0,0.188,0 в командному рядку – висота елемента. 
4. В наступному полі  в командному рядку вводимо 0.104 – радіус 

світлодіода. 
5. Наступне поле – мінімальний радіус – вводимо 0.0. 
6. Далі – початковий кут – вводимо 0.0. 
7. В наступному полі  вводимо 360.0 – кінцевий кут. 
З’явиться вікно Thermal Model Data. 
8. Відкриваємо закладку Numbering. 
9. В позиції  Submodel пишемо Ldiod. 
10. Відкриваємо закладку Cond/Cap. 
Перед тим, як відкриється потрібна закладка, з’явиться вікно із запитанням 

«Чи потрібно додати модель плати в лист проекту?» 
11. Вибираємо Yes. 
12. В позиції Cond Submodel вибираємо LDIOD. 
13. В позиції Material вибираємо Ldiod. 
14. Натискаємо OK, щоб закрити діалогове вікно. 
Отримаємо світлодіод на друкованій платі. 
Виділяємо побудований елемент та зробимо його червоного кольору. 
15. Виділяємо світлодіод. 
16. Натискаємо Modify > Move. 
17. Клацаємо на одній з точок світлодіода. 
18. Друкуємо @0, 0.04,0 в командному рядку. 
Світлодіод підніметься над поверхнею друкованої плати. 
 
Приєднання світлодіода до плати тепловою провідністю 

Натискаємо   або Thermal>FD/FEMNetwork>Contactor. 
1. Вибираємо світлодіод. 
2. Натискаємо «Enter». 
3. Вибираємо плату. 
4. Натискаємо «Enter». 
Світлодіод повинен приєднатись до плати.  
З’являється діалогове вікно Contactor. 
5. В рядку Conductor Submodel вибираємо LDIOD. 
6. В рядку Conduction Coefficient вибираємо 5. 
7. Натискаємо OK, щоб закрити діалогове вікно Contactor. 
Як тільки зміни були зроблені, натискаємо OK. З’явиться графічне 

зображення стрілок. 
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Побудова транзисторів 

1. Натискаємо  або Thermal> Surfaces/Solids > Solid Сylindr. 
2. Друкуємо в командному рядку початкову точку на платі для транзистора 

або задаємо її, клацнувши по платі на лінії сітки з урахуванням топології. 
Натискаємо Enter. 

3. Друкуємо @0,0.188,0 в командному рядку – висота транзистора. 
4. В наступному полі  в командному рядку вводимо 0.1 – радіус 

транзистора. 
5. Наступне поле – мінімальний радіус – вводимо 0.0. 
6. Далі – початковий кут – вводимо 0.0. 
7. В наступному полі  вводимо 360.0 – кінцевий кут. 
З’явиться вікно Thermal Model Data. 
8. Відкриваємо закладку Numbering. 
9. В позиції Submodel пишемо Tranz. 
10. Відкриваємо закладку  Cond/Cap. 
Перед тим, як відкриється потрібна закладка, з’явиться вікно із запитанням 

«Чи потрібно додати модель плати в лист проекту?» 
11. Вибираємо Yes. 
12. В позиції  Cond Submodel вибираємо TRANZ. 
13. В позиції  Material вибираємо Tranz. 
14. Натискаємо OK, щоб закрити діалогове вікно. 
Отримаємо транзистор на друкованій платі. 
Виділяємо побудований елемент та зробимо його пурпурового кольору. 
15. Виділяємо транзистор. 
16. Натискаємо  Modify > Move. 
17. Клацаємо на одній з точок транзистора. 
18. Друкуємо @0, 0.04,0 в командному рядку. 
Транзистор підніметься над поверхнею друкованої плати. 
 
Приєднання транзистора до плати тепловою провідністю 

Натискаємо   або Thermal>FD/FEMNetwork>Contactor. 
1. Клацаємо по транзистору. 
2. Натискаємо «Enter». 
3. Клацаємо по платі. 
4. Натискаємо «Enter». 
Транзистор повинен приєднатись до плати.  
З’являється діалогове вікно Contactor. 
5. В рядку Conductor Submodel вибираємо TRANZ. 
6. В рядку Conduction Coefficient вибираємо 5. 
7. Натискаємо OK, щоб закрити діалогове вікно Contactor. 
Як тільки зміни були зроблені, натискаємо OK. З’явиться графічне 

зображення стрілок.  
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Для другого транзистора зробимо ідентичні операції, вказавши лише іншу 

початкову точку. 
Після всіх проведених побудов елементів отримаємо рисунок 3.25 

 

 
 

Рисунок 3.25 – Приєднання підстроювального резистора, світлодіода, 
транзистора 

 
Контактування 
1. Виділяємо усі елементи. 
2. Вибираємо Thermal > Model Checks > Show Contactor Markers. 
Дана функція показує місця контактів елементів з платою. 
Жовті лінії показують місця контакту плати з елементами і зображені на 

рисунку 3.26. 
 

 
 

Рисунок 3.26 – Контактні маркери 
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3. Натискаємо  або Thermal> Model Checks > Clear Contact/or 
Markers. 

Дана команда прибирає поставлені маркери контакта. 
 
Приклад моделювання схеми 
1. Виділимо один елемент. 
2. Натиснемо Thermal > FD\FEM Network>Heat Load on Surfaces 
З’явиться діалогове вікно Heat Load Edit Form, що на рисунку 3.27. 
 

 
 

Рисунок 3.27 – Діалогове вікно Heat Load Edit Form 
 

3. В рядку Logic Submodel вибрати Rez. 
4. В рядку Value задамо  потужність резистора (для нашого випадку 

0,04 Вт). 
5. Натиснемо ОК. 
6. Повторимо процедуру з кожним елементом. Слід вводити знайдені 

(розраховані) значення розсіюваної потужності кожного елемента, відповідно. 
7. Далі натискаємо  або Thermal> Case Set Manager. 
З’явиться діалогове вікно Case Set Manager, за допомогою якого 

геометрична модель змінюється на температурну, що на рисунку 3.28. 
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Рисунок 3.28 – Діалогове вікно Case Set Manager 
 

8. Вибираємо Edit. 
З’явиться діалогове вікно Case Set Information, що на рисунку 3.29. 

 

 
 

Рисунок 3.29 – Діалогове вікно Case Set Information 
 

9. Вибираємо закладку S/F Calculations. 
10. Знімаємо виділення з графи Steady State. 
11. Вибираємо Transient. 
12. У полі End Time вводимо 100. 
13. Вибираємо закладку S/F Output, як зображено на рисунку 3.30. 
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Рисунок 3.30 – Діалогове вікно Case Set Information (закладка S/F 
Output) 

 
14. У полі Output Increment вводимо 10. 
15. Натискаємо ОК. 
На екрані з’явиться діалогове вікно Case Set Manager. 
16. Вибираємо Run Case. 
З’явиться діалогове вікно SINDA/Fluint Run Status. 
17. Натискаємо ОК. 
18. Натискаємо  або Thermal> Post Processing > Animate Through Time. 
З’явиться діалогове вікно Continuous Cycle Dialog, як на рисунку 3.31. 

 

 
 

Рисунок 3.31 – Діалогове вікно Continuous Cycle Dialog 
 

19. Натискаємо ОК. 
20. Спостерігаємо за екраном. 
Дана функція показує зміни температурного тону об’єкта під час його 

нагрівання у динамічному вигляді, що на рисунку 3.32. 
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21. Натискаємо  або Thermal> Post Processing > Post Processing Off. 
Модель повернеться до геометричного вигляду. 
22. Виділяємо плату. 
23. Вибираємо Thermal > Post Processing > X-Y Plot Data vs. Time. 
24. Проаналізуємо результат моделювання. 
Ця команда викликає програму XYPlotting. Програма рисує графіки для тих 

точок, які були вибрані з об’єкта (рисунок 3.33). 
 

 
 

Рисунок 3.32 – Діалогове вікно, на якому показано зміни 
температурного тону об’єкта під час його нагрівання у динамічному вигляді 

 

 
 

Рисунок 3.33 – Діалогове вікно, на якому показано результати роботи 
програми XYPlotting 
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25. Виділяємо елементи на платі. 
26. Вибираємо Thermal > Post Processing > X-Y Plot Data vs. Time. 
27. Проаналізуємо результат. 
На рисунку 3.34 зображено діалогове вікно, на якому показано графіки для 

тих точок, які були вибрані з об’єкта. 
 

 
 

Рисунок 3.34 – Діалогове вікно, на якому показано графіки для тих 
точок, які були вибрані з об’єкта 

 
Створення граничної точки, задання температури зовнішнього середовища 

1. Натискаємо  або Thermal > FD/Fem Network > Node. 
2. Вводимо 0.74,0.52,1.44 (координати точки) в  командний рядок. 
Дана точка буде являти собою навколишнє середовище з властивою йому 

температурою та впливати на наш об’єкт так, як це робило б навколишнє 
середовище. 

3. Вибираємо новостворену точку. Точка буде редагуватись для того, щоб 
зробити з неї граничну точку повітря і зробити її частиною навколишнього 
середовища. 

4. Натискаємо  або Thermal>Edit. 
З’явиться діалогове вікно Node, що на рисунку 3.35. 

 

74 



 

 
 

Рисунок 3.35 – Діалогове вікно Node 
 

5. У полі Submodel друкуємо Air. 
6. У полі Type вибираємо Boundary (границя). 
7. Двічі клацнемо мишею у полі Initialtemp. 
З’явиться діалогове вікно Expression Editor, що на рисунку 3.36. 

 

 
 

Рисунок 3.36 – Діалогове вікно Expression Editor 
 

8. Натискаємо на кнопку Symbol Manager. 
З’явиться діалогове вікно Symbol Manager, що на рисунку 3.37. 
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Рисунок 3.37 – Діалогове вікно Symbol Manager 
 

9. Вводимо Airtemp у рядку New Symbol Name. 
10. Натискаємо Add. 
З’явиться вікно Expression Editor. 
11. Друкуємо 298 у полі Airtemp, що на рисунку 3.38. 

 

 
 

Рисунок 3.38 – Вікно Expression Editor 
 

12. Натискаємо ОК. 
13. Натискаємо Done. 
Вводимо Airtemp в поле Expression. 
14. Натискаємо ОК. 
15. Натискаємо ОК. 
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З’явиться запит про додання нових даних до існуючого проекту. 
16. Натискаємо Yes. 
Як тільки усі операції будуть завершені, буде створено точку, яка 

символізуватиме навколишнє середовище, та буде задано температуру 
навколишнього середовища. Після завершення операцій точка змінить форму, 
що свідчитиме про те, що усе зроблено правильно. 

 
Створення провідників між зовнішнім середовищем та пристроєм 

1. Натискаємо  або друкуємо layer у командному рядку. 
З’явиться діалогове вікно Layer Properties Manager, що на рисунку 3.39. 

 

 
 

Рисунок 3.39 – Діалогове вікно Layer Properties Manager 
 

2. Вибираємо New. 
3. Змінюємо назву нового шару на Conductors. 
4. Натискаємо на іконку On, щоб вимкнути новостворений шар. 
5. Натискаємо ОК, щоб закрити діалогове вікно. 
Новий шар створюється для провідників, які розташовуватимуться в ньому. 

Шар вимикається для того, щоб при розміщенні в ньому провідників, вони 
зникали і не загромаджували робочий екран. 

 
Створення провідників 

1. Натискаємо  або Thermal > FD/Fem Network > Node to Surface 
Conductor. 

2. Вибираємо граничну точку. 
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3. Вибираємо поверхню, як показано на рисунку, наведеному нижче. (Вибір 

поверхні проведемо  таким чином, щоб у прямокутник потрапили  плата та 
мікросхема). 

 
Правила виділення 
При виділенні елемента від точки 1 до точки 2, виділяться усі елементи, які 

повністю або частково увійшли до виборочного прямокутника. 
При виділенні елементів від точки 2 до точки 1, виділяться лише ті 

елементи, які повністю увійшли до виборочного прямокутника. 
Натискаємо «Enter». 
Після завершення усіх кроків на екрані повинен з’явитись рисунок, схожий 

на рисунок 3.40. 
 

 
 

Рисунок 3.40 – Створення провідників 
 

Переміщення провідників до провідного шару  
1. Вибираємо новостворені провідники. 

2. Натискаємо  або Thermal > Edit. 
З’явиться діалогове вікно Conductor. 
3. Друкуємо Side Convectionу полі Comment. 
4. У полі Submodel вибираємо Board. 
На рисунку 3.41 зображено діалогове вікно Conductor. 
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Рисунок 3.41 – Діалогове вікно Conductor 
 

5. Натискаємо ОК, щоб закрити діалогове вікно. 
6. Вибираємо новостворені провідники. 

7. Натискаємо  або набираємо Properties у командному рядку. 
З’явиться діалогове вікно Properties, що на рисунку 3.42. 
 

 
 

Рисунок 3.42 – Діалогове вікно Properties 
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8. Натискаємо на поле Layer та вибираємо Conductors. 
Дані команди переміщують провідники до провідного шару. Провідники 

зникають з екрана, роблячи його менш завантаженим. 
З’явиться запит на підтвердження переміщення об’єкта у вимкнений шар. 
9. Натискаємо ОК. 
10. Закриваємо вікно властивостей. 

 
Моделювання теплових характеристик плати з точкою обдуву 
1. Натискаємо  або Thermal> Case Set Manager. 
2. Вибираємо Run Case. 
З’явиться діалогове вікно SINDA/Fluint Run Status. 
3. Натискаємо ОК. 
Коли відбудуться всі зміни із переходу до температурного вигляду, маємо 

отримати результат, схожий на той, що подано на рисунку 3.43. 
 

 
 

Рисунок 3.43 – Моделювання теплових характеристик плати з точкою 
обдуву 

 
4. Натискаємо  або Thermal>PostProcessing>PostProcessing Off. 
Модель повернеться до геометричного вигляду. 
5. Виділяємо плату. 
6. Вибираємо Thermal > Post Processing > X-Y Plot Data vs. Time. 
7. Проаналізуємо результат. 
На рисунку 3.44 зображено діалогове вікно, на якому показано програму 

XYPlotting. А на рисунку 3.45 зображено діалогове вікно, на якому показано 
графіки для тих точок, які були вибрані з об’єкта. 
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Рисунок 3.44 – Діалогове вікноз програмою XYPlotting 
 

8. Виділяємо елементи на платі. 
9. Вибираємо Thermal > Post Processing > X-Y Plot Data vs. Time. 
10. Проаналізуємо результат. 

 

 
 

Рисунок 3.45 – Діалогове вікно, на якому показано графіки для тих 
точок, які були вибрані з об’єкта 

 
Вимкнення граничної точки 

1. Натискаємо  або Thermal>Preferences. 
З’явиться діалогове вікно User Preferences. 
2. Вибираємо закладку Graphics Visibility. 
3. Вимкнемо функцію User Defined Nodes. 
На рисунку 3.46 зображене Діалогове вікно User Preferences 
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Рисунок 3.46 – Діалогове вікно User Preferences 
 

4. Натискаємо ОК. 
Після виконання всіх операцій гранична точка, яка характеризувала 

зовнішнє середовище, зникне з екрана. 
 

Моделювання теплових характеристик плати в корпусі 
1. Після вимкнення точки обдуву (граничної точки), плата перебуває у 

повітрі. Виділяємо існуючу алюмінієву пластину. Вибираємо Thermal > Edit. 
З’явиться вікно Thermal Model Data. Вибираємо закладку Contact. У ділянці 
Edges активуємо всі рядки та встановимо значення 5 у кожному полі W/in/K. 
Це ж саме повторюємо для плати. 

2. Додамо до наявної алюмінієвої пластини ще 5, щоб утворити корпус. Для 

цього використовуємо  або Thermal>Surfaces/Solids>Rectangle. 
Команда: _RcRectangle. 
Для 2-ої стінки в командному рядку запишемо: 
0,0 або вибравши  курсором 
@0,0.96,0 
@0,0,1.4 
здійснимо аналогічні операції для інших 4-х стінок. 
3. Змінимо колір утвореного корпусу на блідно-сірий. 
4. Виділимо верхню частину корпусу . 
Корпус також можна утворити шляхом включення плати всередину 

пустотілого паралелепіпеда. 

5. Натискаємо  або друкуємо layer у командному рядку. 
З’явиться Діалогове вікно Layer Properties Manager. 

 
Переміщення кришки до провідного шару 
1. Вибираємо New. 
2. Змінюємо назву нового шару на Сover. 
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3. Натискаємо на іконку On, щоб вимкнути новостворений шар. 
4. Натискаємо ОК, щоб закрити діалогове вікно. 
Новий шар створюється для верхньої кришки корпусу, яка 

розташовуватиметься в ньому. Шар вимикається для того, щоб при розміщенні 
в ньому кришки вона зникала і було видно деталі всередині корпусу. 

5. Виділяємо верхню алюмінієву пластину. 

6. Натискаємо  або Properties у командному рядку. 
7. З’явиться діалогове вікно Properties. 
8. Натискаємо на поле Layer та вибираємо Сover. 
Дані команди переміщують кришку до провідного шару. Кришка зникає з 

екрану. 
З’явиться запит на підтвердження переміщення об’єкта у вимкнений шар. 
9. Натискаємо ОК. 
10. Закриваємо вікно властивостей. 
 
Моделювання теплових характеристик плати в корпусі 
1.Натискаємо  або Thermal > Case Set Manager. 
2.Вибираємо Run Case. 
З’явиться Діалогове вікно SINDA/Fluint Run Status. 
3. Натискаємо ОК. 
Коли відбудуться всі зміни із переходу до температурного вигляду, маємо 

отримати результат, схожий на той, що зображено на рисунку 3.47. 
 

 
 

Рисунок 3.47 – Моделювання теплових характеристик плати в корпусі 
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4. Натискаємо  або Thermal > Post Processing > Post Processing Off. 
Модель повернеться до геометричного вигляду. 
5. Виділяємо плату. 
6. Вибираємо Thermal > Post Processing > X-Y Plot Data vs. Time. 
7. Проаналізуємо результат. 
8. Виділяємо елементи на платі. 
9. Вибираємо Thermal > Post Processing > X-Y Plot Data vs. Time. 
10. Проаналізуємо результат. 

 
Створення граничної точки для плати в корпусі 

1. Натискаємо  або Thermal> FD/Fem Network > Node. 
2. Поставимо граничну точку у будь-якому місці всередині корпусу. 
3. Вибираємо новостворену точку.  

4. Натискаємо  або Thermal > Edit. 
З’явиться діалогове вікно Node, що на рисунку 3.48. 
 

 
Рисунок 3.48 – Діалогове вікно Node 

 
5. У полі Submodel вибираємо Air. 
6. У полі Type вибираємо Boundary (границя). 
7. Двічі клацаємо мишею у полі Initialtemp. 
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З’явиться діалогове вікно Expression Editor, що на рисунку 3.49. 

 

 
 

Рисунок 3.49 – Діалогове вікно Expression Editor 
 

8. Натискаємо Insert. 
9. Натискаємо ОК. 
10. Натискаємо ОК. 
Як тільки усі операції будуть завершені, буде створено точку, яка 

символізуватиме навколишнє середовище, та буде задано температуру 
навколишнього середовища. Після завершення операцій, точка змінить форму, 
що свідчитиме про те, що усе зроблено правильно. 

 
Створення провідників між зовнішнім середовищем та пристроєм 

1. Натискаємо  або друкуємо layer у командному рядку. 
З’явиться Діалогове вікно Layer Properties Manager. 
2. Вибираємо шар Conductors,увімкнемо його. 
3. Натискаємо ОК, щоб закрити діалогове вікно. 

4. Натискаємо  або Thermal  > FD/Fem Network > Node to Surface 
Conductor. 

5. Вибираємо граничну точку. 
6. Вибираємо поверхню. 
7. Натискаємо «Enter». 
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Після завершення усіх кроків на екрані повинен з’явитись рисунок, схожий 

на рисунок 3.50. 
 

 
 

Рисунок 3.50 – Провідники 
 

8. Вимикаємо провідники, щоб вони не загромаджували модель. 
 
Моделювання теплових характеристик плати з точкою обдуву 
1. Натискаємо  або Thermal > Case Set Manager. 
2. Вибираємо Run Case. 
З’явиться Діалогове вікно SINDA/Fluint Run Status. 
3. Натискаємо ОК. 
Коли відбудуться всі зміни із переходу до температурного вигляду, маємо 

отримати результат, схожий на той, що подано на рисунку 3.51. 
 

 
 

Рисунок 3.51 – Моделювання теплових характеристик плати з точкою 
обдуву 
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4. Натискаємо  або Thermal>PostProcessing>PostProcessing Off. 
Модель повернеться до геометричного вигляду. 
5. Виділяємо плату. 
6. Вибираємо Thermal > Post Processing > X-Y Plot Data vs. Time. 
7. Проаналізуємо результат. 
8. Виділяємо елементи на платі. 
9. Вибираємо Thermal > Post Processing > X-Y Plot Data vs. Time. 
10. Проаналізуємо результат. 

3.2.2  Приклад побудови пристрою охолодження 

Визначення параметрів основних матеріалів 
1. Вибираємо Thermal > Thermophysical Properties > Edit Property Data. 
На рисунку 3.52 зображене Діалогове вікно Edit Optical Properties. 
 

 
 

Рисунок 3.52 – Діалогове вікно Edit Optical Properties 
 

2. Вибираємо «Aluminum» у «New property to add». 
3. Натискаємо кнопку Add. 
З’явиться Діалогове вікно Thermophysical Properties. 
4. У розділі Conductivity (провідність) у рядку k вводимо 237. 
5. У розділі Specific Heat (тепло) даного меню у рядку ср вводимо 900. 
Ця частина вправи визначає термофізичні властивості для алюмінію і 

мікросхеми. 
Стандартними одиницями вимірювання для Thermal Desktop є система 

одиниць СІ. Одиниці, які відповідають деяким властивостям: 
W/m/K для провідності; 
J/Kg/K для теплоти; 
kg/m^3 для концентрації. 
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Рисунок 3.53 – Вікно Thermophysical Properties 
 

На рисунку 3.53 зображене вікно Thermophysical Properties. 
6. У розділі Density (концентрація) в рядку rho вводимо значення 2702. 
7. Вибираємо OK. 
Знову з’явиться вікно Edit Thermophysical Properties, в якому буде 

відображатись рядок з заданим матеріалом та його заданими властивостями. 
8. Друкуємо Water в «Newpropertytoadd», щоб додати ділянку поверхні 

кристала без компонентів. 
9. Натискаємо кнопку Add. 
10. У розділі Conductivity (провідність) у рядку k вводимо 0.6. 
11. У розділі Specific Heat (тепло) у рядку ср вводимо 4200. 
12. У розділі Density (концентрація) в рядку rho вводимо значення 1000. 
13. Вибираємо OK. 
Знову з’явиться вікно Edit Thermophysical Properties, в якому буде 

відображатись рядок з заданим матеріалом та його заданими властивостями. 
14. Вибираємо OK для закриття вікна Edit Thermophysical Properties. 
 
Настроювання графічних опцій 

1. Натискаємо  або Thermal>Preferences. 
2. Вибираємо закладку Unitsі в полі ModelLength (одиниці виміру) задаємо 

in (дюйми). 
3. Вибираємо закладку Graphics Visibility та натискаємо на TD/RC 

Nodes,щоб зняти виділення. 
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Натискаємо ОК, щоб закрити вікно. 
 
Побудова основи пристрою 

Натискаємо  або Thermal> Surfaces > Disk. 
В командному рядку з’явиться запит про те, де потрібно розташувати центр 

диска. 
Друкуємо 0,0 в командному рядку. 
В командному рядку з’явиться запит про те, де потрібно розташувати центр 

– вісь Z. 
3. Друкуємо 0,0,1 в командному рядку. 
В командному рядку з’явиться запит про те, яким має бути максимальний 

радіус диска. 
4. Друкуємо 1.3125 в командному рядку. 
В командному рядку з’явиться запит про те, яким має бути мінімальний 

радіус диска. 
Друкуємо «Enter» в командному рядку. 
В командному рядку з’явиться запит про те, яким має бути початковий кут 

для побудови диска. 
Друкуємо «Enter» в командному рядку. 
В командному рядку з’явиться запит про те, яким має бути кінцевий кут для 

побудови диска. 
Друкуємо «Enter» в командному рядку. 
Дані операції відповідають за створення основи для алюмінієвого корпусу. 
З’явиться вікно Thermal Model Data 
8. Виберіть закладку Subdivision. 
9. Виберіть поле Edge Nodes. 
10. В полі Angular Equal введіть 9. 
11. В полі Radial Equal введіть 3. 
12. Виберіть закладку Cond/Cap. 
13. У полі Material виберіть Aluminum та встановіть товщину шару 0,05. 
14. Натисніть ОК, щоб закрити вікно. 

15. Натисніть або View > Zoom > Extents. 
Коли закінчите, даний диск буде являє собою основу для системи 

охолодження. 
 
Побудова оболонки пристрою 
1. Виберіть новостворений диск. 
2. Виберіть Thermal > FD/Fem Network > Extrude Normal To Planar 

Elements into Solids. 
З’явиться вікно Extrude/Revolve Planar Elements to Solids, що на 

рисунку 3.54. 
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Рисунок 3.54 – Вікно Extrude/Revolve Planar Elements into Solids 
 

3. В рядку Total Distance введіть 4.75. 
4. В рядку Solids created along path введіть 4. 
5. В рядку ID increment for new nodes введіть 100. 

 

 
 

Рисунок 3.55 – Вікно Extrude/Revolve Planar Elements into Solids 
 

На рисунку 3.55 зображене вікно Extrude/Revolve Planar Elements into Solids. 
6. Натисніть ОК, щоб закрити діалогове вікно. 
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Зміна матеріалу субмоделей елементів 

1. Натисніть  або Thermal > Edit. 
2. Надрукуйте all в командному рядку. 
3. Натисніть «Enter». 
З’явиться вікно Object Selection Filter, що на рисунку 3.56. 

 
Рисунок 3.56 – Вікно Object Selection Filter 

 
4. Виберіть Solid Elements(64). 
5. Натисніть ОК, щоб закрити діалогове вікно. 
Новостворений елемент потрібно відредагувати таким чином, щоб змінити 

його матеріал на воду. 
З’явиться вікно Solid Elements Attributes, що на рисунку 3.57. 
 

 
 

Рисунок 3.57 – Вікно Solid Elements Attributes 
 

6. В полі Material виберіть Water. 
7. Натисніть ОК, щоб закрити діалогове вікно. 
8. Прочитайте інформацію у діалоговому вікні, яке з’явиться на екрані, та 

натисніть Yes. 
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Вибір параметрів матеріалу субмоделей 
1. Виберіть Thermal > FD/Fem Network > Surface Coat Free Solid Faces. 
2. Надрукуйте all в командному рядку. 
3. Натисніть «Enter». 
З’явиться вікно Thermal Model Data – Multiple Surface/Element Edit Mode, 

що на рисунку 3.58. 
 

 
 

Рисунок 3.58 – Вікно Thermal Model Data – Multiple Surface/Element 
Edit Mode 

 
4. Виберіть закладку Cond/Cap. 
5. В полі Material виберіть Aluminum та встановіть товщину шару 0,03. 
6. Натисніть ОК, щоб закрити діалогове вікно. 
Навколо елемента, який складається з води, розміщується алюмінієва 

оболонка. 
7. Прочитайте інформацію у діалоговому вікні, яке з’явиться на екрані, та 

натисніть Yes. 

8. Натисніть  або Veiw > Zoom > Extents. 
 

Задання початкової температури пристрою 

1. Натисніть  або Thermal > Edit. 
2. Надрукуйте all в командному рядку. 
3. Натисніть «Enter». 
З’явиться вікно Object Selection Filter. 
4. Виберіть Nodes(85) у вікні, що з’явилося. 
5. Натисніть ОК, щоб закрити діалогове вікно. 
З’явиться вікно Node – Multi Edit Mode, що на рисунку 3.59. 
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Рисунок 3.59 – Вікно Node – Multi Edit Mode 
 

6. У рядку Initial temp введіть 278.15 (0 °С = 273.15 К) 
7. Натисніть ОК, щоб закрити діалогове вікно. 
8. Прочитайте інформацію у діалоговому вікні, яке з’явиться на екрані, та 

натисніть Yes. 
Дана вправа редагує усі вузли для встановлення їх початкової температури. 
 
Створення граничної точки та задання температури зовнішнього 

середовища 

1. Натисніть  або Thermal > FD/Fem Network > Node. 
2. Введіть 3,0,0 (координати точки) у командному рядку. 
Дана точка буде являти собою навколишнє середовище з властивою йому 

температурою та впливати на наш об’єкт так, як це робило б навколишнє 
середовище. 

3. Виберіть новостворену точку. Точка буде редагуватись для того, щоб 
зробити з неї граничну точку повітря і зробити її частиною навколишнього 
середовища. 

4. Натисніть  або Thermal > Edit. 
З’явиться діалогове вікно Node, що на рисунку 3.60. 
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Рисунок 3.60 – Діалогове вікно Node 
 

5. У полі Submodel надрукуйте Air. 
6. У полі Type виберіть Boundary (границя). 
7. Двічі клацніть мишею у полі Initial temp. 
З’явиться діалогове вікно Expression Editor, що на рисунку 3.61. 

 

 
 

Рисунок 3.61 – Діалогове вікно Expression Editor 
 

8. Натисніть на кнопку Symbol Manager. 
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З’явиться діалогове вікно Symbol Manager, що на рисунку 3.62. 
 

 
 

Рисунок 3.62 – Діалогове вікно Symbol Manager 
 

9. Введіть Airtemp у рядку New Symbol Name. 
10. Натисніть Add. 
З’явиться вікно Expression Editor. 
11. Надрукуйте 20 у полі Airtemp. 
12. Натисніть ОК. 
13. Натисніть Done. 
14. У рядку Select units for: Temperature оберіть С. 
15. Введіть Airtemp в поле Expression. 
16. Натисніть ОК. 
17. Натисніть ОК. 
З’явиться запит про додання нових даних до існуючого проекту. 
18. Натисніть Yes. 
Як тільки усі операції будуть завершені, буде створено точку, яка 

символізуватиме навколишнє середовище, та буде задано температуру 
навколишнього середовища. Після завершення операцій точка змінить форму, 
що свідчитиме про те, що усе зроблено правильно. 

 
Створення провідників між зовнішнім середовищем та пристроєм 
1. Виберіть View > 3D Views > Front. 
2. Надрукуйте Zoom у командному рядку. 
3. Надрукуйте 0.9х у командному рядку. 
Зміна вигляду SW Isometric до вигляду Front. 
Вигляд після виконання даних функцій. 

4. Натисніть  або надрукуйте layer у командному рядку. 
З’явиться діалогове вікно Layer Properties Manager, що на рисунку 3.63. 
5. Виберіть New. 
6. Змініть назву нового шару на Conductors. 
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7. Натисніть на іконку On, щоб вимкнути новостворений шар. 
8. Натисніть ОК, щоб закрити діалогове вікно. 
Новий шар створюється для провідників, які розташовуватимуться в ньому. 

Шар вимикається, щоб не загромаджувати робочий екран. 
 

 
 

Рисунок 3.63 – Діалогове вікно Layer Properties Manager 
 

Вибір граничної точки для створення джерела охолодження 

1. Натисніть  або Thermal > FD/Fem Network > Node to Surface 
Conductor. 

2. Виберіть граничну точку. 
3. Виберіть поверхню, як показано на рисунку 3.64. 

 
 

Рисунок 3.64 – Вибір точок на поверхні охолоджувального пристрою 
4. Натисніть «Enter». 
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Вибір об’єктів, що охолоджуються 
При виборі об’єктів у AutoCAD велике значення має спосіб вибору (з якої 

сторони починається виділення об’єкта), тому потрібно уважно слідкувати за 
ілюстраціями, які наводитимуться при подальшому розгляді програми. 

На екрані з’являться 8 ліній, які будуть іти від точки до поверхні об’єкта та 
являтимуть собою провідники. 

1.Виберіть новостворені провідники. 

2. Натисніть  або Thermal > Edit. 
З’явиться діалогове вікно Conductor, що на рисунку 3.65. 
 

 
 

Рисунок 3.65 – Діалогове вікно Conductor 
 

3. Надрукуйте Top Convection у полі Comment. 
4. У полі Type виберіть Natural Convection Horizontal Flat Plate Upside. 
5. У полі Area/Perimeter введіть 0.65625. 
6. Натисніть ОК, щоб закрити діалогове вікно. 
Деякі параметри для диска: 
area = pi*r^2 
perimeter = pi*r*2 
Area/Perimeter = radius/2 
radius = 1.3125. 
 
Переміщення об’єкта у вимкнений шар 
1. Виберіть новостворені провідники. 

2. Натисніть  або наберіть Properties у командному рядку. 
З’явиться діалогове вікно Properties, що на рисунку 3.66. 
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Рисунок 3.66 – діалогове вікно Properties 
 

3. Натисніть на поле Layer та виберіть Conductors. 
Дані команди переміщують провідники до провідного шару. Провідники 

зникають з екрана, роблячи його менш завантаженим. 
З’явиться запит на підтвердження переміщення об’єкта у вимкнений шар. 
4. Натисніть ОК. 
5. Закрийте вікно властивостей. 
 
Створення теплових провідників в області охолодження 

1. Натисніть  або Thermal > FD/Fem Network > Node to Surface 
Conductor. 

2. Виберіть граничну точку. 
3. Виберіть поверхню, як показано на рисунку 3.67. 
 

 
 

Рисунок 3.67 – Створення провідників 
 

Вибір точок на бічній поверхні охолоджувального пристрою. 
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Правила виділення. 
При виділенні елемента від точки 1 до точки 2, виділяться усі елементи, які 

повністю або частково увійшли до вибіркового прямокутника. 
При виділенні елементів від точки 2 до точки 1, виділяться лише ті 

елементи, які повністю увійшли до вибіркового прямокутника. 
4. Натисніть «Enter». 
5. Виберіть новостворені провідники. 

6. Натисніть  або Thermal > Edit. 
З’явиться діалогове вікно Conductor. 
7. Надрукуйте Side Convection у полі Comment. 
8. У полі Type виберіть Natural Convection Vertical Cylinder – Isothermal. 
9. У полі Height введіть 4.75. 
10. У полі Diameter введіть 2.625. 

 

 
 

Рисунок 3.68 – Діалогове вікно Conductor 
 

На рисунку 3.68 зображено діалогове вікно Conductor. 
11. Натисніть ОК, щоб закрити діалогове вікно. 
 
Переміщення провідників до теплопровідного шару 
1. Виберіть новостворені провідники. 

2. Натисніть  або наберіть Properties у командному рядку. 
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З’явиться діалогове вікно Properties, що на рисунку 3.69. 
 

 
 

Рисунок 3.69 – Діалогове вікно Properties 
 

3. Натисніть на поле Layer та виберіть Conductors. 
Дані команди переміщують провідники до провідного шару. Провідники 

зникають з екрана, роблячи його менш завантаженим. 
З’явиться запит на підтвердження переміщення об’єкта у вимкнений шар. 
4. Натисніть ОК. 
5. Закрийте вікно властивостей. 
 
Вимкнення граничної точки 

1. Натисніть  або Thermal > Preferences. 
З’явиться діалогове вікно User Preferences. 
2. Виберіть закладку Graphics Visibility. 
3. Вимкніть функцію User Defined Nodes. 

 

 
 

Рисунок 3.70 – Діалогове вікно User Preferences 
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4. Натисніть ОК. 
Після виконання всіх операцій гранична точка, яка характеризувала 

зовнішнє середовище, зникне з екрана. 
 

Підготовка зовнішнього вигляду пристрою до моделювання. Моделювання 
теплових процесів 

1. Натисніть  або надрукуйте layer у командному рядку. 
З’явиться діалогове вікно Layer Properties Manager. 
2. Виберіть New. 
3. Змініть назву нового шару на Right Side. 
4. Натисніть на іконку On, щоб вимкнути новостворений шар, як на 

рисунку 3.71. 
 

 
 

Рисунок 3.71 – Діалогове вікно Layer Properties Manager 
 

Натисніть ОК, щоб закрити діалогове вікно. 
 
Перевірка властивостей охолоджувального пристрою 
1. Виберіть праву частину охолоджувального пристрою, як показано на 

рисунку, наведеному нижче. 
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Рисунок 3.72 – Вибір правої частини пристрою 
 

2. Натисніть  або наберіть Properties у командному рядку. 
З’явиться діалогове вікно Properties. 
3. Натисніть на поле Layer та виберіть RightSide. 
З’явиться запит про перенесення виділених елементів у заданий шар. 
4. Натисніть ОК. 
5. Закрийте вікно властивостей. 
6. Виберіть View > 3D Views > SE Isometric. 
 

 
 

Рисунок 3.73 – Вигляд пристрою охолодження після виконання функції 
SE Isometric View 

 
На рисунку 3.73 зображено вигляд пристрою охолодження після виконання 

функції SE Isometric View. 
7. Натисніть  або Thermal > Model Checks > Color by Property Value > 

Conductivity. 
Дана команда перевіряє правильність розташування матеріалів. Якщо усе 

правильно, на екрані повинен з’явитись рисунок, аналогічний рис. 3.74. 
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Рисунок 3.74 – Перевірка властивостей охолоджувального пристрою 
 

8. Натисніть  або Thermal>Model Checks>Color by Property Value > 
Off. Дана функція поверне екран до попереднього вигляду. 

3.2.3  Моделювання 

1. Натисніть  або Thermal > Case Set Manager. 
З’явиться діалогове вікно Case Set Manager, за допомогою якого 

геометрична модель змінюється на температурну, що на рисунку 3.75. 
 

 
 

Рисунок 3.75 – Діалогове вікно Case Set Manager 
 

2. Виберіть Edit. 
З’явиться діалогове вікно Case Set Information, що на рисунку 3.76. 
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Рисунок 3.76 – Діалогове вікно Case Set Information 
 

3. Виберіть закладку S/F Calculations. 
4. Зніміть виділення з графи Steady State. 
5. Виберіть Transient. 
6. У полі End Time введіть 3600. 
7. Виберіть закладку S/F Output, що на рисунку 3.77. 

 

 
 

Рисунок 3.77 – Діалогове вікно Case Set Information (закладка S/F 
Output) 
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8. У полі Output Increment введіть 100. 
9. Натисніть ОК. 
На екрані з’явиться діалогове вікно Case Set Manager. 
10. Виберіть Run Case. 
З’явиться діалогове вікно SINDA/Fluint Run Status. 
11. Натисніть ОК. 
Коли відбудуться всі зміни із переходу до температурного вигляду, маємо 

отримати результат, схожий на той, що подано на рисунку 3.78. 
 

 
 

Рисунок 3.78 – Моделювання 
 

12. Натисніть  або Thermal > Post Processing > Edit Current Dataset. 
З’явиться діалогове вікно Set SINDA Dataset Properties, що на рисунку 3.79. 

 

 
 

Рисунок 3.79 – Діалогове вікно Set SINDA Dataset Properties 
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13. У полі Select a Time/Record [seс] виберіть 3600. 
14. Натисніть ОК. 
Після виконання даних функцій на екрані з’явиться температурна модель 

пристрою після проходження певного часу від початку нагрівання, як на 
рисунку 3.80. 

 

 
 

Рисунок 3.80 – Температурна модель пристрою після проходження 
певного часу від початку нагрівання 

 
Температурна модель пристрою після виконання функції Post Processing. 
15. Натисніть  або Thermal > Post Processing > PostProcessing Off. 
Модель повернеться до геометричного вигляду. 
16. Натисніть  або Thermal > Case Set Manager. 
З’явиться діалогове вікно Case Set Manager. 
17. Виберіть Copy. 
З’явиться діалогове вікно Add New Case Set, що на рисунку 3.81. 
 

 
 

Рисунок 3.81 – Діалогове вікно Add New Case Set 
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18. У рядку New Case Set Name введіть Hot Case. 
19. Натисніть ОК. 
20. Виберіть Hot Case. 
21. Виберіть Edit 
З’явиться діалогове вікно Case Set Information – Hot Case. 
Виберіть закладку Symbols, що на рисунку 3.82. 
 

 
 

Рисунок 3.82 – Діалогове вікно Case Set Information – Hot Case 
 

22. Виберіть Airtemp у полі Global List. 
23. Натисніть на кнопці right arrow посередині вікна. 
З’явиться діалогове вікно Expression Editor. 
24. У полі Airtemp змініть величину з 20 на 25. 
25. Натисніть ОК. 
 

 
 

Рисунок 3.83 – Діалогове вікно Case Set Information – Hot Case 
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26. Натисніть ОК. 
27. Виберіть Run Case. 
З’явиться діалогове вікно SINDA/Fluint Run Status. 
28. Натисніть ОК. 
Коли всі операції будуть виконані, результат повинен бути схожий на 

рисунок 3.84. 
 

 
 

Рисунок 3.84 – Моделювання 

29. Натисніть  або Thermal > Post Processing > Edit Current Dataset. 
З’явиться діалогове вікно Set SINDA Dataset Properties. 
30. У полі Select a Time/Record [seс] виберіть 3600. 
31. Натисніть ОК. 
32. Натисніть  або Thermal > Utilities > Capture Graphics Area. 
Дана команда зберігає вигляд вікна у вигляді рисунка формату bmp. 
33. Натисніть  або Thermal > PostProcessing > Animate Through Time. 

З’явиться діалогове вікно Continuous Cycle Dialog, що на рисунку 3.85. 
 

 
 

Рисунок 3.85 – Діалогове вікно Continuous Cycle Dialog 
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34. Натисніть ОК. 
35. Спостерігайте за екраном. 
Дана функція показує зміни температурного тону об’єкта під час його 

нагрівання у динамічному вигляді. 
36. Натисніть  або Thermal > Post Processing > PostProcessing Off. 
Модель повернеться до геометричного вигляду. 
37. Виділіть елемент, що знаходиться на екрані. 
38. Виберіть Thermal > Post Processing > X-Y Plot Data vs. Time. 
39. Розбирайтесь з результатом. 
Дана команда викликає програму XY Plotting. Програма малює графіки для 

тих точок, які були вибрані з об’єкту. 
Користувач може змінювати вибрані точки та об’єкти за допомогою 

команди Data Sets > Open. 
40. Виберіть File > Exit. 
41. Виберіть ОК. 
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Контрольні запитання 
 
1. Побудувати плату, розмістити на ній резистор, приєднати його до плати 

тепловою провідністю та провести моделювання розподілу теплових 
полів друкованої плати у вакуумі. 

2. Побудувати плату, розмістити на ній світлодіод, приєднати його до плати 
тепловою провідністю та провести моделювання розподілу теплових 
полів друкованої плати у вакуумі. 

3. Побудувати плату, розмістити на ній транзистор КТ972 (Р = 8 Вт, висота 
– 10,8 мм, ширина – 7,8 мм, товщина – 2,8 мм; провідність – 51 W/m/K; 
теплота випромінювання – 490 J/kg/K; густина – 3160 Kg/m3), приєднати 
його до плати тепловою провідністю та провести моделювання 
розподілу теплових полів друкованої плати у вакуумі. 

4. Побудувати плату, розмістити на ній транзистор КТ805А (Р = 30 Вт, 
висота – 11 мм, d1 = 22 мм, d1 = 23,5 мм; провідність – 51 W/m/K; теплота 
випромінювання – 490 J/kg/K; густина – 3160 Kg/m3), приєднати його до 
плати тепловою провідністю та провести моделювання розподілу 
теплових полів друкованої плати у вакуумі. 

5. Побудувати плату, розмістити на ній транзистор КТ848А (Р = 35 Вт, 
висота – 10,3 мм, d = 20,1 мм; провідність – 51 W/m/K; теплота 
випромінювання – 490 J/kg/K; густина – 3160 Kg/m3), приєднати його до 
плати тепловою провідністю та провести моделювання розподілу 
теплових полів друкованої плати у вакуумі. 

6. Побудувати плату, розмістити на ній декілька елементів, приєднати їх до 
плати тепловою провідністю, створити граничну точку зовнішнього 
середовища, задати температуру зовнішнього середовища та провести 
моделювання розподілу теплових полів. 

7. Побудувати плату, розмістити на ній декілька елементів, приєднати їх до 
плати тепловою провідністю, створити граничну точку зовнішнього 
середовища, задати температуру зовнішнього середовища, створити 
провідники між зовнішнім середовищем та пристроєм та провести 
моделювання розподілу теплових полів. 
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ГЛОСАРІЙ 
Апаратура – equipment. 
Аргумент – parameter. 
Базові системи – barebone systems. 
Блочно – ієрархічний-block-hierarchical. 
Виводи – leads. 
Висота – height. 
Витрати – consumption. 
Вихідне – output. 
Відведення тепла – heat rejection. 
Внутрішні лінії – internal lines. 
Вуглекислота – carbonic acid. 
Вхідне – input. 
Габаритні розміри – overall dimension. 
Гранична точка – boundary point. 
Джерела тепла – sources of heat. 
Довжина – length. 
Допустима – permissible. 
Дюйм – inch. 
Емпіричні коефіцієнти – empirically determined coefficients. 
Ескізне – sketchy. 
Жалюзі – shutters. 
Зниження – reduction. 
Закон збереження енергії – law of conservation of energy, energy 

(conservation) law. 
Замикання – shorting. 
Зниження – reduction. 
Ізотермічні поверхні – isothermal surfaces. 
Інтенсивність – intensity. 
Інтервал температур – temperature range. 
Інтерфейс користувача – user interface. 
Кінцеве – finite. 
Кнопка – button. 
Коефіцієнт випромінення – emissivity. 
Коефіцієнт витрат – cost coefficient. 
Коефіцієнт запасу – reserve coefficient. 
Коефіцієнт тепловіддачі – heat-transfer coefficient. 
Коефіцієнт теплопередачі – surface-area factor. 
Комплекс – system. 
Конвективний – convective. 
Конструктивний вузол – structural assembly. 
Конструювання – construction , design. 
Концентрація – density, (розчину) strength. 
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Координатна сітка – grid. 
Кремнієвий – silicon. 
Критичне значення – critical value. 
Критичний елемент – bottleneck. 
Куб – cube. 
Ламінарний рух – streamline motion. 
Лінія насичення – saturation line. 
Локальна – local. 
Малопотужний – low-power. 
Маркер – token. 
Масообмінні – mass exchanged. 
Масштабний коефіцієнт – scale factor. 
Математичний опис – mathematical formulation. 
Мікросхема – integrated circuit. 
Нагріта – heated. 
Надійність – reliability. 
Нескінченно довгі – infinitely long. 
Номінальна – rated. 
Об’ємні витрати – volumetric loss. 
Одиниця вимірювання – unit. 
Оптимізація – refinement, refining. 
Орієнтація поверхні – surface orientation. 
Отвори – aperture,hole, perforation. 
Панель інструментів – toolbar. 
Паралелепіпед – parallelepipedon. 
Перепад тисків – pressure difference. 
Перехідний – transition. 
Периметр – circumfery, perimeter. 
Перфорований – punched, perforated. 
Питома теплоємність – specific heat. 
Підсилювачі звукових частот – acoustic amplifiers. 
Підстроювальний резистор – trimming resistor. 
Плоска – plane. 
Площа поверхні – surface area. 
Повітряне охолодження – air cooling, air-to-air cooling. 
Помилки обчислення – computational error. 
Попереднє – preliminary. 
Поперечний – diametrical, transversal. 
Посадкові поверхні – landing surfaces. 
Потужність – capacity, power. 
Припущення – assumptions. 
Прискорення сили тяжіння – gravity. 
Провідники – conductors. 
Продуктивність – efficiency. 
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Проникність – penetration. 
Прямокутник – rectangle. 
Радіатори – heaters. 
РЕА – electronics. 
Розсіювана потужність – dissipation. 
Світлодіод – LED, light diode. 
Світлотінь – treatment of light and shade. 
Середня температура – mean temperature. 
Середньоарифметичне – arithmetical mean. 
Середовище – medium. 
Силова конструкція – load-bearing unit. 
Ступінь – stage, phase. 
Сухе повітря – dry air. 
Сферичні – spherical. 
Теплова провідність – thermal conductivity. 
Тепловий аналіз – thermoanalysis. 
Тепловий баланс – heat balance. 
Теплові потоки – heat current. 
Тепловіддача – heat-release. 
Теплоємність – heat capacity. 
Теплонапружені – high-beat. 
Теплообмін – heat transfer. 
Теплоперенесення – heat transmission. 
Термогідравлічне – thermohydraulic. 
Термофізичні властивості – thermophysical properties. 
Термочутливі – heat-sensitive. 
Тиск – pressure. 
Товщина стінок – gauge. 
Точка розгалуження – junction. 
Траєкторія – path, trajectory. 
Транзистор – transistor. 
Турбулентний – turbulent. 
Установочні площі – locating pads. 
Умови експлуатації – external environment. 
Фільтри – filters; sifters. 
Фон – background. 
Число Рейнольда – Reynolds number,Reynolds' number. 
Шар – layer. 
Шасі – chassis, mounting. 
Швидкість руху повітря – air speed. 
Ширина – width. 
Штрихування – shading. 
Щільність – density. 
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